
MALDI Source

Getting Started Guide

97155-97012 Revision A February 2008



© 2008 Thermo Fisher Scientific Inc. All rights reserved.

Xcalibur is a registered trademark of Thermo Fisher Scientific Inc. in the United States.

LTQ XL, Data Dependent, Dynamic Exclusion, Ion Mapping, ZoomScan, Wideband Activation, 
ImageQuest, and BioWorks are trademarks of Thermo Fisher Scientific Inc. 

The following are registered trademarks in the United States and other countries. Microsoft, Windows, and 
Excel are registered trademarks of Microsoft Corporation. TurboSEQUEST is a registered trademark of the 
University of Washington. ProteoMass is a registered trademark of Sigma-Aldrich Biotechnology LP and 
Sigma-Aldrich Co. ZipTip is a registered trademark of Millipore Corporation. Chromasolv is a registered 
trademark of Sigma-Aldrich Biotechnology LP and Sigma-Aldrich Co.

OMIX is a trademark of Varian, Inc. ZipTip is a trademark of Millipore Corporation.

All other trademarks are the property of Thermo Fisher Scientific Inc. and its subsidiaries.
Thermo Fisher Scientific Inc. provides this document to its customers with a product purchase to use in the 
product operation. This document is copyright protected and any reproduction of the whole or any part of this 
document is strictly prohibited, except with the written authorization of Thermo Fisher Scientific Inc.

The contents of this document are subject to change without notice. All technical information in this 
document is for reference purposes only. System configurations and specifications in this document supersede 
all previous information received by the purchaser. 

Thermo Fisher Scientific Inc. makes no representations that this document is complete, accurate or error-
free and assumes no responsibility and will not be liable for any errors, omissions, damage or loss that might 
result from any use of this document, even if the information in the document is followed properly. 

This document is not part of any sales contract between Thermo Fisher Scientific Inc. and a purchaser. This 
document shall in no way govern or modify any Terms and Conditions of Sale, which Terms and Conditions of 
Sale shall govern all conflicting information between the two documents.
Release history: Revision A released February 2008.

Software Version: Xcalibur 2.0.7 or higher, MALDI Source 2.5.0, LTQ Series 2.5

For Research Use Only. Not regulated for medical or veterinary diagnostic use by U.S. Federal Drug 
Administration or other competent authorities.



Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described below.

EMC Directive 204/108/EC
EMC compliance has been evaluated by TUV Rheinland of North America.

Low Voltage Safety Compliance
This device complies with Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1:2001.

Safety of Laser Products
Compliance with safety of laser products is declared under Thermo Fisher Scientific sole responsibility. This device 
complies with the harmonized standard IEC/EN 60825-1/A2: 2001.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

FCC Compliance Statement
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THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.



Notice on Lifting and Handling of
Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy and/or bulky for one 
person alone to handle safely.

Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.
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Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each 
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See www.thermo.com/WEEERoHS for further information on Thermo Fisher Scientific’s compliance 
with these Directives and the recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC 
erfüllen.  Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-
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Conformité DEEE
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Preface

This guide describes how to calibrate and tune your MALDI LTQ XL™ system, and how to 
acquire matrix-assisted laser desorption/ionization (MALDI) data. It also provides a brief 
introduction to processing your MALDI MS/MS data using the BioWorks™ data analysis 
program.

Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the following documents for the 
MALDI source:

• MALDI Source Hardware Manual

• LTQ Series Preinstallation Requirements Guide

• LTQ Series Getting Connected Guide

The software also provides Help.

Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

CAUTION  Highlights hazards to humans, property, or the environment. Each CAUTION 
notice is accompanied by an appropriate CAUTION symbol. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or contains information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.
Thermo Scientific MALDI Source Getting Started Guide xi
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xii
Contacting Us
There are several ways to contact Thermo Fisher Scientific. 

To contact Technical Support

Find software updates and utilities to download at www.mssupport.thermo.com.

To contact Customer Service for ordering information

To suggest changes to documentation or to Help

• Fill out a reader survey online at www.thermo.com/lcms-techpubs.

• Send an e-mail message to the Technical Publications Editor at 
techpubs.finnigan-lcms@thermofisher.com.

Tip  Highlights helpful information that can make a task easier.

Phone 800-685-9535
Fax 561-688-8736
E-mail TechSupport.C+MS@thermofisher.com
Knowledge base www.thermokb.com

Phone 800-532-4752
Fax 561-688-8731
Web site www.thermo.com/finnigan
MALDI Source Getting Started Guide Thermo Scientific
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Introduction

The Thermo Fisher Scientific MALDI source produces ions from mixed matrix/analyte 
microcrystals under low-pressure conditions by irradiating these crystals with pulses of light 
from a nitrogen laser. When you use this ion source with the LTQ XL mass spectrometer, you 
can perform sensitive analyses of intact molecules, using only small amounts of sample 
material. 

What is Matrix-Assisted Laser Desorption/Ionization?
Matrix-assisted laser desorption/ionization (MALDI) is an effective mass spectrometry tool 
for a wide variety of large, labile biomolecules. By using the MALDI tool, you can transfer 
molecules directly from the solid phase to the gas phase as intact ions. 

As Figure 1 shows, the MALDI method of introducing analyte ions into the mass 
spectrometer includes these basic steps:

1. You mix the analyte with a suitable matrix, dry this mixture on a target plate, and insert 
the target plate into the sample module of the MALDI LTQ XL system.

2. The XYZ mechanism of the sample module moves the target plate into a vacuum 
chamber where the remaining solvent evaporates. 

3. The MALDI nitrogen laser fires pulses of UV light. The MALDI X-Y stage moves the 
selected spot on the target plate in line with the laser beam.

4. The energy from the UV light desorbs the analyte and matrix material from the target 
plate. 

Contents

• What is Matrix-Assisted Laser Desorption/Ionization?

• Why Use the LTQ XL Mass Spectrometer?

• What Are the Data Acquisition Features of the MALDI Source?

• What Types of Experiments Can I Perform?

• What is Tuning and Calibration of the LTQ Mass Spectrometer?
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5. The MALDI source grounds the target plate and the LTQ XL mass spectrometer places 
an electrostatic charge on the aperture of the ion transfer optics. In the positive ion 
polarity mode, the LTQ XL mass spectrometer places a negative charge on the aperture. 
In the negative ion polarity mode, the LTQ XL mass spectrometer places a positive 
charge on the aperture.

Figure 1. MALDI sample preparation (panel A) and ionization (panel B)

Because the sample quality affects the production and quality of the ions introduced into the 
mass spectrometer, the most important step in the MALDI process is sample preparation. 
Variables that influence the production and quality of ions with the MALDI source include 
the concentration of the matrix and analyte, choice of matrix, analyte history (for example, 
exposure to strong ionic detergents or formic acid), and contaminants. For more information 
on preparing samples for MALDI analysis, see Appendix B, “Sample Preparation.” 

The preferred method for sample preparation is the dried-droplet method. Using this 
method, you mix a very dilute solution of the analyte (picomoles/microliter to 
femtomoles/microliter) with a solution of the matrix compound. The matrix compound is 
typically a small organic acid that absorbs energy at the wavelength of the laser. To form the 
sample, the analyst deposits approximately 0.5 to 1 μL of the mixture on a target plate. When 
the mixture dries, a solid deposit of analyte-doped matrix crystals remains. The large molar 
excess of matrix compound ensures that the analyte molecules are distributed throughout the 
matrix crystals. 

During the desorption and ionization step, short pulses of laser light strike the target. Because 
the matrix is in excess and has a high molar absorptivity coefficient at the 337 nm wavelength 
produced by the laser, it absorbs essentially all of the incident radiation, minimizing analyte 
damage and fragmentation. While the actual mechanism of ionization is unknown, the 
predominant theory is that the laser light causes intense heating in the matrix. This heating 

+

+

+

+

(A) (B)

Target plate

Matrix

Sample

Laser
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leads to vibrational excitation of the matrix and localized deterioration of the solid solution. 
The matrix molecules vaporize and form a rapidly expanding plume of ejected material. This 
matrix plume carries some analyte molecules into the vacuum. The ion-molecule reactions in 
the gas phase or simple desorption of preformed ions from solution then ionize the analyte 
molecules. 

After the analyte molecules are vaporized and ionized, they are transferred electrostatically to 
the mass spectrometer to be analyzed.

Why Use the LTQ XL Mass Spectrometer?
The LTQ XL mass spectrometer provides multiple stages of mass analysis for positive 
compound identification. The LTQ XL also provides features that improve mass resolution 
and enhanced structural information.

The various stages of mass analysis provided by the LTQ XL are as follows:

• Mass analysis (molecular mass information): Single-stage mass analysis provides 
molecular mass information for the identification of analytes of interest.

• MS/MS (structural information): Two-stage mass analysis provides even more positive 
compound identification. MS/MS analysis monitors how precursor ions fragment when 
exposed to an additional stage of ionization. 

There are two types of MS/MS analysis: 

− Full-scan MS/MS: monitors the production of all product ions from a specific 
precursor ion. 

− SRM MS/MS: monitors a specific reaction path involving the production of a 
specific product ion from a specific precursor ion. 

Using MS/MS analysis, you can easily quantitate target analytes in complex matrices such 
as plant or animal tissue, plasma, urine, groundwater, or soil. Because of the specificity of 
MS/MS measurements and the ability to eliminate interferences by an initial mass 
selection stage, you can easily accomplish quantitative target compound analysis using the 
LTQ XL mass spectrometer. Due to the complex nature of matrix assisted laser 
desorption, you typically use isotopic labels for quantitation. A discussion on using 
isotope labels to improve quantitation is beyond the scope of this manual.

• MSn (structural information): Multi-stage mass analysis provides a unique capability to 
obtain structural information that can be useful in structure elucidation of peptides, 
carbohydrates, lipids, metabolites, and natural products. MSn techniques on the LTQ 
mass spectrometer allow for stepwise fragmentation pathways, making interpretation of 
MSn spectra relatively straightforward. The LTQ mass spectrometer has several advanced 
features that make its MSn capabilities extremely powerful for qualitative analysis. (See 
“What Types of Experiments Can I Perform?” on page 6.)
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The following features provide higher mass resolution information:

• ZoomScan™ analysis (higher mass resolution information): You collect ZoomScan data 
by using slower scans at higher resolution. In the electrospray ionization mode, you can 
use ZoomScan to determine the charge state, which in turn allows for the correct 
determination of molecular mass. Since MALDI produces almost exclusively 
singly-charged ions, ZoomScan with MALDI is primarily used to provide greater mass 
resolution. 

• UltraZoomScan analysis (the highest mass resolution information) produces the highest 
resolution data of the three scan rates (Normal, Zoom, and UltraZoom).

In addition to providing multi-stage mass analysis and high resolution scans, the LTQ XL can 
perform Wideband Activation™, a technique that applies collision energy to ions during 
MS/MS fragmentation over a fixed mass range of 20 u. This technique enables the LTQ XL 
mass spectrometer to apply collision energy to both the precursor ion and the product ions 
created as a result of non-specific losses of water (18 u) or ammonia (17 u), for example, or 
formed from the loss of fragments less than 20 u. 

Use the Wideband Activation technique for qualitative MS/MS when you want enhanced 
structural information in MS/MS. Because the collision energy is applied to a broad mass 
range, this option reduces signal sensitivity. To compensate for the reduction in sensitivity, 
you can increase the value of the collision energy (Activation Amplitude).

With the MALDI source, you can set up high throughput, automated analyses of target plates 
spotted with 96 or 384 samples. You can also set up tissue imaging experiments on tissues 
fixed to glass or stainless steel slides. Because samples are not completely consumed when 
acquiring data with the MALDI source, they are available for future experiments.

What Are the Data Acquisition Features of the MALDI Source?
To automate data acquisition and improve the quality of your data, the MALDI source offers 
these features:

• The Crystal Positioning System (CPS)

• The Automatic Spectrum Filter (ASF)

• The Automatic Gain Control (AGC)

The Crystal Positioning System (CPS) 

The Crystal Positioning System (CPS) automatically selects crystals of the sample/matrix for 
targeting by the laser during data acquisition. When you enable the CPS, the MALDI 
program processes the camera image of the sample well and identifies the location of the 
crystals in the sample/matrix mixture. The program then calculates a path for the sample plate 
motion that keeps the laser targeted at the crystals and skips over those areas of the well that 
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contain little sample deposit. The CPS eliminates the need to manually select the location 
within the sample well where the laser fires, and keeps signal levels consistent even when the 
sample is not deposited evenly in the well. 

In addition to CPS, you can select from a number of predefined plate motion patterns. These 
raster options are spiral outwards, spiral inwards, and zig zag. When using Tune Plus, you can 
also manually select where to fire the laser.

The Automatic Spectrum Filter (ASF) 

The Automatic Spectrum Filter (ASF) feature sets the MALDI program to discard spectra 
that do not have a peak height, total area, or signal-to-noise ratio above a specified threshold 
over a specified mass range. When the ASF discards a spectrum, the MALDI source moves the 
sample plate so that the laser targets the next MALDI crystal in the path. ASF ensures the 
acquisition of optimal-signal spectra and speeds data collection by going to fresh crystals when 
the MALDI signal is not optimal. Spectrum filtering, in conjunction with crystal positioning, 
allows for intelligent data acquisition. The ASF feature is not available in Ion Mapping™ 
experiments. 

The Automatic Gain Control (AGC) 

The Automatic Gain Control (AGC) feature helps you to maintain the quality of the MALDI 
spectra. When you enable AGC, the MALDI data system adjusts the number of laser shots to 
produce the same number of ions for each scan. If the number of ions produced per laser shot 
is low, the laser fires more shots. If the number of ions produced per laser shot is high, the 
laser fires fewer shots. 

AGC in MALDI excludes masses below 500 u when it calculates the ion intensity. When 
AGC is On, MALDI spectra are normalized using the number of laser shots and a 
normalization factor. For this reason, you cannot deduce the actual ion counts directly from 
the parameters in the spectrum. To compare the ion counts between spectra collected with 
AGC On or Off requires a series of calculations beyond the scope of this manual. 

You have the option of enabling AGC when you operate the MALDI source from the Tune 
Plus program. When collecting data automatically using an acquisition sequence in Xcalibur, 
the experiment uses the AGC mode (either On or Off ) from the tune file specified in the 
instrument method. Figure 2 shows the AGC options on the Control page of the MALDI 
Source dialog box, accessed from Tune Plus.

Figure 2. AGC controls on the Control page of the MALDI Source dialog box in Tune Plus
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What Types of Experiments Can I Perform?
You can perform the following types of experiments with the MALDI LTQ XL system:

• General MS or MSn Experiments 

• Data Dependent Experiments 

• Ion Mapping Experiments 

General MS or MSn Experiments

A General MS or MSn experiment acquires one type of spectrum: either a full MS or an MSn 
acquisition. The Xcalibur data system includes an instrument method template for a General 
MS or MSn experiment in Instrument Setup. Use a general MS experiment to acquire full 
scan MS data from a whole MALDI plate (96 or 384 sample wells).

Figure 3 shows an example of an MS experiment with one scan event.

Figure 3. General MS or MSn template with the default settings

Number of experiments
Maximum acquisition time

Plate motion

ASF mass ranges

ASF thresholds

Tune file

Scan 
event 
settings
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You can set the following parameters for an MS experiment: 

• Number of experiments to acquire (how many times a scan event is repeated)

• Maximum acquisition time per sample spot (either the number of experiments or a time 
limit, whichever is achieved first)

• Plate motion (CPS, Spiral Outwards, Spiral Inwards, or Zig Zag)

• Thresholds for ASF settings and their mass ranges

• Tune file (laser energy, AGC option, number of microscans, and number of sweep shots)

• Mass range for the analyte of interest (low, normal, or high)

• Scan rate (normal, Zoom, or UltraZoom)

Typical scan rates with MALDI are normal and Zoom. Use UltraZoom when scanning 
the normal mass range of up to m/z 2000. (The Turbo scan rate is used with an LC run in 
electrospray mode to increase the number of scans across a chromatographic peak. With 
ESI, the Enhanced scan rate provides charge state identification up to charge state 3.)

• Scan type (full or selected ion monitoring, SIM)

• Profile or centroid, positive or negative ion mode

• Scan range values, as defined by the first mass and last mass in the scan range or the center 
mass and width

In Xcalibur, click Help to learn more about each of these parameters.

For an MSn experiment, you also specify the mass-to-charge ratios of all the precursor ions of 
interest, the isolation width, and the collision energy in the MSn settings. The LTQ XL mass 
spectrometer collects data on the ions in the range or on the product ions of the precursor 
ion(s) that you specify.

The LTQ XL mass spectrometer can generate analyte-specific spectra that you can reproduce 
from laboratory to laboratory. Consequently, you can use reference spectra generated with the 
LTQ XL mass spectrometer to confirm structures of compounds generated with other 
LTQ XL systems.

Data Dependent Experiments

Because they can provide structure elucidation, Data Dependent experiments are useful for 
the qualitative analysis of unknown compounds. A Data Dependent experiment can produce 
a composite spectrum of MS2, MS3, and MS4 data and the program can store the MSn 
fingerprint data in a custom MSn library spectrum. The data is valuable for use in process 
control, quality assurance, or research.
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You can approach the setup of Data Dependent experiments in two ways:

• If you know the precursor ion, or if you expect a certain kind of precursor ion, you can set 
up a list of possible precursor ions so that when the mass spectrometer detects one of the 
specified precursor ions, it acquires product spectra. You can also set up a list of ions that 
you do not want the mass spectrometer to fragment.

• If you have little information about your compound, you can set up the parameters of a 
Data Dependent experiment so that the LTQ XL mass spectrometer generates product 
spectra when the intensity of the ion signal is above a specified threshold. Parameters that 
you can specify include threshold values for the intensity of the MS or MSn ion signal. 
The threshold values you choose should successfully isolate the precursor ions of interest. 
These threshold values differ from the ASF thresholds found in the Xcalibur Instrument 
Setup.

You can use the templates in the Xcalibur Instrument Setup in a Data Dependent experiment 
to do the following:

• Identify low-level peptides in complex mixtures of enzymatically digested proteins (using 
Data Dependent MS/MS or Nth Order Double Play). 

• Identify post-translational modifications (such as phosphorylation and glycosylation) 
automatically from intense precursors in a complex peptide mixture (Data Dependent 
Neutral Loss). 

• Identify post-translational modifications through a hypothesis-driven approach by adding 
the mass of the modification to the identified peptides that could harbor such 
modifications and placing these in a Precursor List.

• Identify proteins by peptide mass fingerprinting using full MS at ZoomScan rate or using 
the first full MS from the Nth Order Double Play experiment, using the deisotoping 
option in BioWorks. (See Chapter 9, “Identifying Proteins Using BioWorks.” )

• Quantitate isotopically labeled peptides from a ratio of peaks in the same MALDI 
spectrum.

Instrument Setup contains the following templates for setting up Data Dependent 
experiments: 

• Data Dependent MS/MS Template

• Data-Dependent Triple Play Template

• Nth Order Double Play Template

• Nth Order Triple Play Template
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Data Dependent MS/MS Template

Even with the simplest data-dependent experiment (Data Dependent MS/MS template) in 
which you specify the MS scan range but do not specify a precursor ion, you can 
automatically find useful structural information about your compound. With these 
parameters, the LTQ XL mass spectrometer collects full-scan MS data over the specified 
range, picks the most intense precursor ion in the spectrum, and then fragments the ion to 
generate product ions. 

Figure 4 shows the default settings for the Data Dependent MS/MS template. With the 
default settings, this template has two scan events. The second scan event is data dependent. 

Figure 4. Data Dependent MS/MS template with the default settings

Click to open the Data Dependent Settings dialog box.
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As Figure 5 shows, you can use the Data Dependent MS/MS template to set up neutral loss 
experiments. 

Figure 5. Data dependent settings for a Data Dependent MS/MS experiment

Data-Dependent Triple Play Template

A Data Dependent Triple Play experiment collects full-scan MS data, and then uses 
ZoomScan to determine the charge state of the precursor ion. With the m/z information 
obtained from the full-scan MS data and the charge state information obtained from the 
Zoomscan, the program calculates the molecular mass of the precursor ion. The precursor ion 
is then fragmented into product ions (MS/MS). Because MALDI ions are predominantly 
singly charged, this experiment type is more useful for the ESI mode.

Figure 6 shows the Data Dependent Triple Play template with the default settings.
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Figure 6. Data Dependent Triple Play template with the default settings

Three scan events

Zoom scan rate
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Nth Order Double Play Template

Because the Nth Order Double Play Data Dependent experiment automatically performs 
MS/MS scans on multiple ions with intensities above a specified threshold, it is the most 
common type of experiment performed with the LTQ XL mass spectrometer in both the 
ESI and MALDI modes. For this type of experiment, specify the number of times that 
Scan Event 2 repeats. The data-dependent scans (Scan Event 2) are performed on the N most 
intense ions detected in Scan Event 1, starting with the most intense ion and proceeding in 
order of decreasing intensity. You can collect up to 50 MS/MS scans in a single experiment 
and you can acquire up to 10000 experiments per data file. For MALDI, limit the number of 
experiments per data file to two. See Figure 7 and Figure 8.

Figure 7. Nth Order Double Play dialog box

Selects the N most intense peaks 
in the MS scan. 
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Figure 8. Nth Order Double Play template (with advanced features)

For MALDI, limit the number 
of experiments to 2.
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Figure 9 shows some common settings for the Dynamic Exclusion™ parameters in an Nth 
Order Double Play experiment. You can use the dynamic exclusion parameters to maximize 
the number of compounds analyzed in the MS/MS scans.

Exclusion duration and Exclusion mass width (by mass) are the two most important dynamic 
exclusion parameters. Set the exclusion duration to a value greater than the expected time to 
perform the method. Set the exclusion mass width to an m/z range that includes the whole 
isotopic envelope of the precursor ion to ensure each MS/MS scan is of a unique (by 
molecular weight) precursor. Figure 10 shows an example of the isotopic envelope of 
Melittin, a peptide in the High Mass Calibration Mix. With an exclusion mass width of 
1.50 m/z on the low-end and 4.0 m/z on the high-end of the mass range, the LTQ XL mass 
spectrometer performs an MS/MS scan on the most intense peak at 2846.82 m/z and ignores 
the remaining peaks between 2845.32 m/z and 2850.82 m/z.

Repeat count and Repeat duration are used with LC-ESI-MS experiments. 

Figure 9. Nth Double Play experiment (Dynamic Exclusion parameters)
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Figure 10. Isotopic envelope of Melittin (peptide in the High Mass Calibration Mix)

Figure 11 shows the Experiment parameters for an Nth Order Double Play experiment. By 
default, none of the check boxes are selected. These features are generally not used for a 
MALDI experiment.

(M+H)+ Monoisotopic Mass 
2845.75 m/z

Isotopic envelope

Most intense peak in isotopic envelope
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Figure 11. Nth Order Double Play (Experiment parameters)

Figure 12 shows the default Current Scan Event parameters in an Nth Double Play template. 
The settings in the Current Scan Event parameters page define the criteria by which the 
dependent scan is executed or not executed. The dependent scan event is only executed if the 
selected ion satisfies all specified criteria in a prior scan event. 
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Figure 12. Nth Double Play experiment (Current Event parameters)

Nth Order Triple Play Template

Use this template to set up a special type of Data Dependent Triple-Play experiment in which 
you specify the number of ions (N) you want to further analyze in the independent scan 
performed in Scan Event 1. 

The dependent scans are performed on the N most intense ions detected in independent 
Scan Event 1. These start with the most intense ion (N=1) and proceed in the order of 
intensity (N=2, 3, 4, and so on.) The maximum number of ions in Scan Event 1 that can be 
selected is 9. 

Data-Dependent Zoom Map Experiments

A Data Dependent Zoom Map is an Ion Mapping™ experiment that collects ZoomScan data 
on every scan interval in a specified mass range, as well as data-dependent MS/MS product 
spectra on every mass above an intensity threshold.

A Data Dependent Zoom Ion Map experiment consists of an independent MS ZoomScan 
scan with isolation of precursor masses in the Zoom mass range, which is the range of 
precursor masses isolated as specified by the ZoomScan width. During subsequent cycles 
through this step, the parent (precursor) mass is incremented by the Zoom mass step size. 
ASF settings are not available in this experiment.
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Figure 13 shows the Data Dependent Zoom Ion Map template with default settings.

Figure 13. Data Dependent Zoom Ion Map template with default settings

Tip  To review the data, open the raw data file in Xcalibur Qual Browser, and view the ion 
map by choosing View > Ion Map.
MALDI Source Getting Started Guide Thermo Scientific



 1 Introduction
What Types of Experiments Can I Perform?

T

Data-Dependent Ion Tree Experiments

The Data Dependent Ion Tree experiment provides methods for automatically collecting and 
interpreting MSn data and arranging the data in formats that are easy to manipulate. You can 
specify a particular precursor ion for fragmentation, or you can let the LTQ XL mass 
spectrometer find the precursor ions automatically and fragment them to any level between 
MS2 and MS10. The LTQ XL mass spectrometer automates the collection of data by 
determining what actions need to occur next for the experiment to progress. These methods 
allow you to perform Data Dependent MSn scans on up to 25 ions per scan. 

In an Ion Tree experiment, use the Breadth Focus or Depth Focus option to prioritize how 
the LTQ mass spectrometer gathers information. Independent of the focus type (Depth or 
Breadth), specify a maximum depth and a maximum breadth for the experiment. The 
maximum depth is the maximum MSn levels analyzed. The maximum breadth is the 
maximum number of ions analyzed at each MSn level.

Breadth Focus characterizes the specified number of ions at the same MSn level before 
advancing to the next MSn level. For example, if you specify a Max Breadth of 3 and a Max 
Depth of 3, the mass spectrometer performs MS/MS scans on the first, second, and third 
most intense peaks in the MS scan. It then performs MS3 scans on the first second, and third 
most intense peaks in the MS/MS scan. 

Depth Focus characterizes an ion by performing a series of MSn-level fragmentations (for 
example, MS/MS, MS3, MS4) before characterizing the next most intense ion in the MS scan. 
For example, if you specify a Max Depth of 4 [MS4] and a Max Breadth of 2, the mass 
spectrometer performs the MS/MS, MS3, and MS4 scans on the first most intense peak of the 
MS scan. Then it performs the MS/MS, MS3, and MS4 scans on the second most intense 
peak of the MS scan. 

You can review the results of a Data Dependent Ion Tree experiment in the Xcalibur Qual 
Browser window. The results are displayed as a structure tree that originates from a particular 
precursor ion. 

Ion Mapping Experiments

Use an Ion Mapping experiment to get full structural characterization of unknown molecules 
in complex mixtures. In an Ion Mapping experiment, you can get product ion scans on every 
precursor ion over a specified mass range. An Ion Mapping experiment can help to identify 
automatically which precursor ions were fragmented to yield a specified product ion. The 
experiment maps one or more precursor ions by using the information from product ion 
scans. 

Note  The Total Ion Map, Neutral Loss Ion Map, and Precursor Ion Map experiments 
described in this topic are not Data Dependent. 
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The LTQ XL program includes the following Ion Mapping templates in Instrument Setup: 

• Total (Full Scan) Ion Mapping Experiments

• Neutral Loss Ion Mapping Experiments

• Precursor Ion Mapping Experiments

These Ion Mapping experiments require a stable signal throughout the length of the 
experiment. To achieve signal stability, it is important to prepare homogeneous sample spots. 
For best results, use the Crystal Positioning System (CPS) feature of the MALDI source to 
help maintain signal stability. The Automatic Spectrum Filtering (ASF) feature is not 
available for Ion Mapping experiments, because it could interfere with maintaining a stable 
signal. See “What Are the Data Acquisition Features of the MALDI Source?” on page 4 for 
more information about these features.

Total (Full Scan) Ion Mapping Experiments

In a total (or full-scan) Ion Mapping experiment, you get product ion scans for each precursor 
ion. These scans provide information that you can use to determine which precursor ions lost 
a particular fragment to yield a particular product ion. You can also determine which 
precursor ions are related to specific product ions. For example, you can map the spectral 
peaks in a mass range from m/z 600 to m/z 2000 and scan for MS/MS product ions in 
incremental steps of every mass-to-charge ratio, every fifth mass-to-charge ratio, or every tenth 
mass-to-charge ratio. Figure 14 shows an example of the settings for a total Ion Mapping 
experiment.
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Figure 14. Total Ion Map settings

Neutral Loss Ion Mapping Experiments

A Neutral Loss Ion Mapping experiment collects scans for masses that have lost neutral 
fragments. As with full scan Ion Mapping, you can get product ion scans on every precursor 
ion. However, a neutral loss ion map experiment identifies which precursor ions lost a neutral 
fragment of a particular mass. For example, you can specify a neutral loss of 80 u (as in the 
case of a phosphorylated peptide in a tryptic digest). A neutral loss ion mapping experiment 
can step through each product mass in the mixture searching for evidence of the loss of a 
neutral moiety of mass 80 u. See Figure 15.

Parent mass range

Product mass range

CPS plate motion
hermo Scientific MALDI Source Getting Started Guide 21



1 Introduction
What Types of Experiments Can I Perform?

22
Figure 15. Neutral loss ion map settings

Precursor Ion Mapping Experiments

A Precursor Ion Mapping experiment identifies all the ions that produce a particular 
molecular ion. For example, if you specify a product ion mass of m/z 100, a precursor ion map 
includes all the precursor ions (parent ions) that yielded that product ion. See Figure 16.

Figure 16. Parent ion mass settings

Parent mass range

Neutral loss mass

Parent mass range

Product ion mass
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What is Tuning and Calibration of the LTQ Mass Spectrometer?
Tune parameters are instrument parameters (for example, laser energy) whose values can vary 
with the type of experiment or analyte being mass analyzed. You tune the instrument on an 
analyte of interest to ensure sensitivity and mass resolution.

Calibration parameters are instrument parameters whose values do not vary with the type of 
experiment. You calibrate the mass spectrometer to ensure mass accuracy. Thermo Fisher 
Scientific recommends that you calibrate the mass spectrometer at least once every three 
months, or whenever you notice a decrease in system performance. 

To tune and calibrate the MALDI LTQ XL system, you perform these basic steps:

1. Prepare a fresh calibration mixture and spot it onto a target plate. 

2. Acquire a mass spectrum of the calibration mixture to make sure that the mass 
spectrometer is operating properly and that you can get a good signal. 

3. Use the automatic tuning procedure in Tune Plus to ensure a laser energy that is high 
enough to produce a good signal-to-noise ratio for the ions in the calibration mixture, but 
not so high that it causes space charging in the ion trap. Space charging, caused by too 
many ions in the trap, reduces mass resolution and causes mass shifts.

4. Use the automated calibration procedure to calibrate the mass spectrometer. 

See Chapter 5, “Tuning and Calibrating in the MALDI Mode,” for detailed instructions on 
tuning and calibrating the MALDI LTQ XL system.
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Setting Up the Xcalibur Instrument Configuration

This chapter describes how to add the LTQ XL mass spectrometer and the MALDI source to 
the Xcalibur Instrument Configuration and specify some of their configuration options.

Adding the MALDI LTQ XL to the Xcalibur Instrument Configuration
To control the MALDI source and the LTQ XL mass spectrometer from the Xcalibur data 
system, add these devices to the software configuration using the Xcalibur Instrument 
Configuration program. 

To add the LTQ XL MS and MALDI source to the list of Configured Devices

1. Because the Xcalibur Instrument Configuration program cannot be open simultaneously 
with the Xcalibur data system or the Tune Plus program, close the Xcalibur data system 
and the Tune Plus program if they are open. 

2. Open the Xcalibur Instrument Configuration program: 

• Choose Start > All Programs > Xcalibur > Instrument Configuration. 

• From the computer desktop, double-click the  Xcalibur Instrument 
Configuration icon.

The Xcalibur Instrument Configuration dialog box appears. See Figure 17. 

Contents

• Adding the MALDI LTQ XL to the Xcalibur Instrument Configuration

• Specifying the Configuration Options for the LTQ XL

• Specifying the Configuration Options for the MALDI Source
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Figure 17. Xcalibur Instrument Configuration dialog box

3. Select the devices that you want to control from the Xcalibur data system:

a. In the Device Types list, select ALL.

b. In the Available Devices list, double-click LTQ XL MS. 

A copy of the LTQ XL MS button appears in the Configured Devices list. See 
Figure 18.

c. In the Available Devices list, double-click MALDI Source.

A copy of the MALDI Source button appears in the Configured Devices list. See 
Figure 18.
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Figure 18. Instrument Configuration dialog box with configured devices

Xcalibur now recognizes the LTQ XL mass spectrometer and the MALDI source as 
devices currently in use. 

4. Do not close the Instrument Configuration dialog box. Go to the next topic, “Specifying 
the Configuration Options for the LTQ XL.” 

Double-click the 
configured device

Clicking Done closes the Xcalibur 
Instrument Configuration program.
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Specifying the Configuration Options for the LTQ XL 
Use the Xcalibur Instrument Configuration program to specify the configuration options for 
the LTQ XL mass spectrometer. This topic describes how to specify the MALDI source as the 
default ion source. 

To specify the configuration options for the LTQ XL instrument 

1. Add the LTQ XL mass spectrometer to the list of configured devices as described in the 
previous topic, “Adding the MALDI LTQ XL to the Xcalibur Instrument 
Configuration” on page 25. 

2. Double-click  LTQ XL MS in the Configured Devices list. 

The LTQ XL Configuration dialog box appears. See Figure 19.

Figure 19. LTQ XL Configuration dialog box

3. In the list on the left side of the dialog box, select Ion Source. 

The Default source list appears. 

4. In the Default source list, select MALDI as shown in Figure 20.
MALDI Source Getting Started Guide Thermo Scientific



 2 Setting Up the Xcalibur Instrument Configuration
Specifying the Configuration Options for the LTQ XL

T

Figure 20. LTQ XL Configuration dialog box with the Default source list

See the LTQ XL Help for information about specifying the other configuration options.

5. When you finish selecting the configuration options for the LTQ XL mass spectrometer, 
click OK. 

Figure 21 shows the LTQ XL Configuration dialog box that appears when you change 
any of the configuration settings.

Figure 21. Confirmation message to change configuration settings

6. Click OK to save the settings and close the LTQ XL Configuration dialog box.

7. Do one of the following:

• To enter the serial number of the MALDI source, go to the next topic, “Specifying 
the Configuration Options for the LTQ XL.” 

• To exit the Xcalibur Instrument Configuration program, click Done. See Figure 18 
on page 27.

Select Ion Source in the list
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Specifying the Configuration Options for the MALDI Source
You do not need to configure the ion source for operation. However, you can use the MALDI 
Source Configuration dialog box to view the serial number and firmware version for the 
MALDI source, and to change the serial number. 

To change a serial number or view the firmware version

1. From the computer desktop, choose Start > All Programs > Xcalibur > Instrument 
Configuration. 

The Xcalibur Instrument Configuration dialog box appears.

2. In the Configured Devices list, double-click  MALDI Source. 

The MALDI Source Configuration dialog box appears. See Figure 22. 

The Serial Number box contains the current entry for the serial number, and the 
Firmware Version readback displays the firmware version of the MALDI source. The 
Firmware Version readback displays a value of Unknown until you run the Tune Plus 
MALDI diagnostics tool for the first time.

Figure 22. MALDI Source Configuration dialog box

3. To change the serial number, type a new number in the Serial Number box. 

4. Click OK to save your changes and close the dialog box. 

5. Click Done to exit the Xcalibur Instrument Configuration program. 
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Preparing for Daily Operation

This chapter describes how to prepare the MALDI LTQ XL system for daily operation.

Contents

• Equipment and Materials Checklist

• Checking the Vacuum Pressure

• Checking the Helium and Nitrogen Gas Supplies

• Placing the LTQ XL System in the On Mode

• Placing the MALDI Source in the On Mode

• Rebooting the MALDI LTQ XL System

• Using the Diagnostics Tool Box
Thermo Scientific MALDI Source Getting Started Guide 31



3 Preparing for Daily Operation
Equipment and Materials Checklist

32
Equipment and Materials Checklist
Check that your laboratory has the following equipment, consumables, and chemicals (see 
Table 1). You must have these items to prepare samples and clean the MALDI target plates. 
In addition, you must also have the ProteoMass™ MALDI Calibration Kit to prepare the 
calibration and sensitivity samples.

For information on preparing the calibration mixtures, see Appendix A, “ProteoMass 
Calibration Kit.” 

Table 1. Equipment and Materials checklist

Equipment

Sonicator bath, approved for use in a chemical hood in the presence of flammable 
vapor, large enough to hold a 1 L beaker or a flat tray that can hold the MALDI plate. 
(The tray must be inert to acetonitrile, methanol, and dilute ammonium hydroxide.)

Microcentrifuge

Vortexer

Pipettors (2.5 μL, 200 μL, and 1000 μL recommended; additional sizes might be 
useful.) 

Analytical balance

Consumables 

Microcentrifuge tubes (500 μL and 1.5 mL non siliconized)

Tips for pipettors, non siliconized

Optical lens wipes or soft clean room wipes

Can of compressed difluoroethane (sold as “compressed air” for dust removal) or 
ultra high purity nitrogen

Chemicals/Solvents (all HPLC grade or better)

Water

Isopropyl alcohol

Methanol

Acetonitrile

Acetone

Trifluoroacetic acid (TFA)

28 to 30% ammonium hydroxide solution
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Checking the Vacuum Pressure
If the Thermo Fisher Scientific field service engineer has just installed the MALDI source, or 
if you have vented the source to atmosphere recently, allow sufficient time for the ion source 
to reach operating vacuum levels before you use the system.

To check the vacuum pressures

1. On the LTQ workstation desktop, choose Start > Programs > Xcalibur > LTQ Tune.

2. If the status view is not displayed, click  (Display Status View).

The status view appears on the right side of the window. The values for Vacuum OK and 
Ion Gauge Pressure OK should be Yes. The value for Upper Chamber should be 
approximately 0.08 Torr (70 to 80 mTorr). See Figure 23.

Figure 23. Tune Plus window with the Status view

Vacuum levels

Display Status View button

Upper Chamber 
vacuum level
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Checking the Helium and Nitrogen Gas Supplies
Be sure to check the helium and nitrogen gas supplies before operating the MALDI LTQ XL 
system. The LTQ XL mass spectrometer uses helium as a damping gas and collision 
activation partner in the mass analyzer. When the LTQ XL mass spectrometer is operated 
in the MALDI mode, the MALDI source uses nitrogen gas to maintain a pressure of 
approximately 75 mTorr in the sample chamber.

To check the helium and nitrogen gas supplies

1. Check that the helium and nitrogen lines are properly connected to the back of the 
LTQ XL mass spectrometer.

For information on checking the nitrogen line connection to the MALDI sample 
compartment, contact your Thermo Fisher Scientific field service engineer.

2. Check that gases are flowing and that the pressure for each gas is correct. 

• The helium pressure should be 40 ± 10 psig (275 ± 70 kPa). 

• The nitrogen pressure should be 100 ± 20 psig (690 ± 140 kPa). 

3. Make sure that you have sufficient gas to complete your analysis. If necessary replace the 
helium or nitrogen tank. 

For more information on gas requirements, see the documentation for the LTQ XL mass 
spectrometer. 
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Placing the LTQ XL System in the On Mode
When you are not using the MALDI LTQ XL system, place the LTQ XL mass spectrometer 
in Standby mode. When you put the LTQ XL mass spectrometer in Standby mode, the 
electron multipliers, conversion dynode, main RF voltage, and ion guide RF voltages turn off. 
The LTQ XL also turns off the nitrogen gas flow to the MALDI sample module. The System 
LED on the front panel of the LTQ XL mass spectrometer is amber when the system is in 
Standby mode.

Before beginning an analysis, take the LTQ XL mass spectrometer out of Standby mode. 
Because the MALDI laser has a limited lifespan, place the MALDI source in the Standby 
mode when it is not in use, even for brief periods. 

To place the LTQ XL mass spectrometer in the On mode

1. On the LTQ workstation desktop, choose Start > All Programs > Xcalibur > LTQ 
Tune. 

2. In the Tune Plus window, click On/Standby  to place the LTQ XL mass 
spectrometer in the On mode.

In the On mode, a green triangle  appears in the top-left corner of the Tune Plus 
window.

The nitrogen supply to the MALDI source automatically turns on. The System LED on 
the front panel of the LTQ XL mass spectrometer turns green. The high voltage to the 
electron multipliers turns on and the MALDI source goes into Standby mode unless you 
have just rebooted the mass spectrometer by pressing the Reset button on the power entry 
panel of the instrument (see “Rebooting the MALDI LTQ XL System” on page 38). 
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Placing the MALDI Source in the On Mode
Table 2 describes the three operation modes for the MALDI source.

To place the MALDI Source in the On mode

Click  Turn on MALDI Source at the bottom of the MALDI Source dialog box. 

The laser starts firing. If the MALDI source has been in Standby mode for more than 
15 minutes, the laser initializes before firing, resulting in a 10 second delay. During this 
delay period, the Standby button flashes on and off and the Start/Stop Acquisition button 
is unavailable. 

To place the MALDI Source in the Standby mode

Click  at the bottom of the MALDI Source dialog box. 

When you are acquiring an Xcalibur raw data file, stopping data acquisition also places 
the MALDI source in the Standby mode. 

Because the MALDI laser has a limited lifespan, place the MALDI source in the Standby 
mode when not in use, even for brief periods. 

Table 2. MALDI source operation modes

Mode Description

Off When the LTQ XL mass spectrometer is in the Off or 
Standby modes, the MALDI source is in the Off mode. 
In the Off mode, the Turn on/Turn off MALDI source 
and the Start/Stop Acquisition buttons at the bottom of 
the MALDI Source dialog box are unavailable.

Standby When the LTQ XL mass spectrometer is in the On 
mode, the MALDI source is in Standby mode, by default.

On Clicking the Standby button, places the MALDI source 
in the On mode. In the On mode, the laser is firing.

Clicking the Start/Stop Acquisition button, starts the 
laser fire, if it is not already firing, and starts data 
acquisition to an Xcalibur raw file. Clicking the 
Start/Stop Acquisition button a second time stops data 
acquisition.
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The Status view displays the following readback states for the MALDI laser: 

• When the MALDI source has been in Standby mode for more than 15 minutes, the 
status readback displays Off. When the laser is in the Off mode, it must go through an 
initialization process before firing. 

• When the laser is not firing (but has fired shots within the last 15 minutes), the status 
readback displays Standby.

• When the laser is firing, the status readback displays Yes (see Figure 24).

Figure 24. Tune Plus window with the Status view showing the laser firing

The Laser Status readback displays 
Yes when the laser is firing. 
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Rebooting the MALDI LTQ XL System
Occasionally, you might need to reboot the LTQ XL mass spectrometer. When you reboot 
the LTQ XL mass spectrometer, the high voltage to the electron multipliers does not turn on 
until you take the LTQ XL mass spectrometer out of Standby mode and place the MALDI 
source in the On mode. 

To reboot the MALDI LTQ XL system

1. Press the Reset button (see Figure 25) on the power entry panel of the LTQ XL mass 
spectrometer.

The instrument goes through an initialization process that you can monitor in the 
LTQ XL console window.

2. In the Tune Plus window, click On/Standby  to turn on the LTQ XL mass 
spectrometer.

3. Click  at the bottom of the MALDI Source dialog box to place the MALDI source 
in the On mode.

4. Click  to place the MALDI source back in the Standby mode.

Figure 25. Power entry panel located on the lower-right side of the MALDI LTQ XL system

Reset button
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Using the Diagnostics Tool Box
The Thermo Fisher Scientific field service engineer uses the Diagnostics tool box during 
installation of the MALDI LTQ XL system. You can also use this feature to provide 
diagnostic information to your Thermo Fisher Scientific field service engineer. 

The following procedures describe how to open the Diagnostics tool box, check the current 
calibration settings, and check the sample plate type:

• Opening the Diagnostics Tool Box

• Displaying the Currently Saved Calibration Settings

• Checking or Selecting the Sample Plate Type

• Adjusting the Video Camera Contrast and Brightness

Opening the Diagnostics Tool Box

To open the Diagnostics tool box

1. Open Tune Plus by doing one of the following:

• From the computer desktop, choose Start > All Programs > Xcalibur > LTQ Tune.

• From the computer desktop, double-click the  LTQ Tune icon.

The Tune Plus window appears. See Figure 26.

Figure 26. Tune Plus window

2. Choose Diagnostics > Diagnostics from the menu bar. 

The Diagnostics dialog box appears.

3. Click Tools. 

Figure 27 shows the Plot readback tool option.
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Figure 27. Plot Readback tools selection in the Diagnostics dialog box 

Displaying the Currently Saved Calibration Settings

You can view the currently saved calibration settings from the Diagnostics dialog box.

To display the currently saved calibration settings

1. Open the Diagnostics tool box as described in the previous topic, “Opening the 
Diagnostics Tool Box.” 

2. In the Tools list, select Display settings. 

Figure 28 shows the Display settings options.
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Figure 28. Display settings options in the Diagnostics dialog box

3. Select the Display calibration settings check box. 

4. Click Start.

The calibration settings appear in the Testing pane. To print the current calibration 
values, click Print. 

The current calibration settings are stored in the MasterLTQ.cal file. You can find this 
file in the following directory:

drive:\Xcalibur\system\LTQ\msx
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Checking or Selecting the Sample Plate Type

If the MALDI system cannot locate the identification marks on the sample plate that you 
have loaded into the sample compartment, it defaults to the Thermo 384 Well Plate type. If 
the data system does not recognize the sample plate type that you have loaded into the 
MALDI sample compartment, you can perform the following diagnostic test.

Table 3 lists the identification marks for the various types of Thermo Scientific plates you can 
use with the MALDI source.

To check the sample plate type

1. Open the Diagnostics tool box as described in “Opening the Diagnostics Tool Box” on 
page 39.

2. In the Tools list, select MALDI.

3. In the Test Name list, select Sample Plate Type Determination. 

A set of check boxes for the sample plate types appears. See Figure 29.

Table 3. Sample plate identification mark

Plate type Identification mark

96-well plate Four squares in a plus sign arrangement

384-well plate Five squares in an X arrangement 

Adapter plate for stainless steel 
slides (tissue imaging)

Capital T

Adapter plate for glass slides 
(tissue imaging)

Capital I
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Figure 29. Sample Plate Type Determination test options

4. Select the AutoConfig Plate Type check box.

5. Click Start.

6. If the camera cannot locate the plate identification marks, do one of the following:

• Increase the video camera contrast and brightness as described in the next procedure, 
“Adjusting the Video Camera Contrast and Brightness.” 

• Select the check box that corresponds to the plate type you have inserted into the 
MALDI sample module, and then click Start.

Adjusting the Video Camera Contrast and Brightness

If the sample plate looks too dark or blurry in the image view of the MALDI Source dialog 
box, or if the camera cannot locate the plate identification marks on the plate, try adjusting 
the video camera contrast and brightness.

To adjust the video camera contrast and brightness

1. Open the Diagnostics tool box as described in “Opening the Diagnostics Tool Box” on 
page 39.
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2. In the Tools list, select MALDI.

3. In the Test Name list, select Video Camera Contrast and Brightness.

The parameters for the Video Camera Contrast and Brightness test appear. See Figure 30.

Figure 30. Video Camera Contrast and Brightness settings

4. Increase the brightness by approximately 20%. 

5. Click OK. 

6. Repeat step 4 and step 5.

7. If the camera cannot locate the plate identification marks after you increase the video 
brightness, remove the plate from the system and clean it.

For more information on the Diagnostics tool box, refer to the MALDI Source Hardware 
Manual.

Note  Clicking the Reset button restores the factory default values for brightness and 
contrast.
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Working with Sample Plates

This chapter describes how to clean a sample plate before you spot it and how to load the 
sample plate into and remove the sample plate from the MALDI sample module.

Preparing the Sample Plate
For accurate analyses, you must clean the sample plate before you spot it with the calibration 
mixtures, the sensitivity test solutions, or your samples.

To prepare the sample plate, follow these procedures:

1. Disassembling the Sample Plate

2. Cleaning the Top Plate of the Sample Plate

3. Assembling the Sample Plate

Contents

• Preparing the Sample Plate

• Loading a Sample Plate into the MALDI Sample Module

• Removing a Sample Plate from the MALDI Sample Module
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Disassembling the Sample Plate

The MALDI sample plate consists of two parts: a top plate, which is engraved in either a 
96-well or 384-well format, and a base plate, on which the top plate is mounted. You only 
need to clean the top plate. 

To remove the top plate from the base plate

1. Wearing gloves, hold the sample plate upside down. Grasp the top plate by the edges, 
being careful not to touch its surface.

2. Pull the latch on the back of the base plate in the direction of the arrow to disengage the 
top plate from the base plate. 

3. Pull the top plate away from the base plate. 

Cleaning the Top Plate of the Sample Plate

Before you prepare the calibration mixture and spot it on the sample plate, clean the surface of 
the sample plate to remove contaminants and ensure a good surface for sample deposition.

Thermo Fisher Scientific recommends the following procedures to clean the surface of the 
sample plate:

• Routine Cleaning

• Deep Cleaning

If the routine cleaning procedure does not remove the surface contamination, try the deep 
cleaning procedure.

IMPORTANT  When handling a sample plate, be sure not to scratch the plate surface. 
Hold the sample plate by the edges. Never touch the plate surface, even when wearing 
gloves.

CAUTION  Using sample plates other than those designed or certified by Thermo Fisher 
Scientific for use with the MALDI source can severely damage the source. 
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Routine Cleaning

Before beginning the routine cleaning procedure, make sure you have the following items 
available:

• Soft wipes (optical lens wipes or soft clean room wipes are recommended to avoid 
scratching the plate surface) 

• Compressed difluoroethane (sold as compressed air for removing dust) or ultra high 
quality nitrogen

• Sonicator (ultrasonic cleaner) 

This procedure also requires the following solvents, which must be HPLC grade or better:

• HPLC grade acetonitrile

• HPLC grade methanol

• 18 MΩ-cm deionized water or HPLC grade water

IMPORTANT  It is best to use gas from an oil-free compressed gas system. Gas from an 
aerosol can contaminate the plate with propellant (liquid difluoromethane). If you 
must use gas from an aerosol can, be sure to prevent the propellant from 
contaminating the plate surface. If you contaminate the plate with propellant, you 
must clean it again. Take the following precautions to avoid getting the propellant on 
the sample plate:

• Do not shake the compressed gas can.

• Keep the can upright when spraying.

• Spray in a series of short bursts rather than in a single continuous stream.

• When the can is close to being empty, replace it with a fresh can.

CAUTION  The sonicator (ultrasonic cleaner) must be approved for use with 
flammable vapors. Perform the sonication in a chemical fume hood.

CAUTION  This procedure uses chemicals that are toxic and volatile. Wear gloves, work in 
a fume hood, and take other appropriate precautions while cleaning the sample plate.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear safety glasses when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 
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To clean the sample plate using the routine cleaning procedure

1. Sequentially rinse the plate with the following solvents and use a soft wipe to wipe the 
surface of the plate dry between each solvent rinse: 

a. Acetonitrile

b. Methanol

c. Water

2. Place the plate in a 1000-mL beaker or similar container. The beaker or container must 
be inert to acetonitrile.

3. Add enough acetonitrile to cover the entire plate. 

4. Cover the beaker with aluminum foil, place it in the sonicator, and sonicate for 
5 minutes.

5. Replace the acetonitrile with methanol and sonicate for 5 minutes.

6. Replace the methanol with water and sonicate for 5 minutes. 

7. Remove the plate from the beaker. 

8. Dry the plate completely with ultra high quality compressed air or ultra high quality 
nitrogen. 

9. Store the plate under vacuum for a few hours to ensure complete dryness. 

Storing the plate under vacuum is especially important when spotting calibration 
samples, since the high organic content of the calibration mix can cause it to spread if the 
plate is not completely dry.

CAUTION  The sonicator (ultrasonic cleaner) must be approved for use with 
flammable vapors. Perform the sonication in a chemical fume hood.
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Deep Cleaning

Before beginning the deep cleaning procedure, make sure that you have the following items 
available:

• Sonicator

• Soft wipes (optical lens wipes or soft clean room wipes to avoid scratching the plate 
surface

• Ultra high quality nitrogen or compressed air in a can, sold as compressed air for 
removing dust 

You must use the following solvents (HPLC grade or better) with this procedure:

• Isopropyl alcohol

• Acetonitrile

• Methanol

• Water

• 30% ammonium hydroxide solution 

Vapors from a solution of 30% ammonium hydroxide can irritate the respiratory tract 
and eyes. Skin contact with this solution can cause burns.

CAUTION  The sonicator (ultrasonic cleaner) must be approved for use with 
flammable vapors. Perform the sonication in a chemical fume hood.

IMPORTANT  It is best to use gas from an oil-free compressed gas system. Gas from an 
aerosol can contaminate the plate with propellant (liquid difluoromethane). If you 
must use gas from an aerosol can, be sure to prevent the propellant from 
contaminating the plate surface. If you contaminate the plate with propellant, you 
must clean it again. Take the following precautions to avoid getting the propellant on 
the sample plate:

• Do not shake the compressed gas can.

• Keep the can upright when spraying.

• Spray in a series of short bursts rather than in a single continuous stream.

• When the can is close to being empty, replace it with a fresh can.

CAUTION  This procedure uses chemicals that are toxic, corrosive, and/or volatile. Wear 
gloves, work in a fume hood, and take other appropriate precautions while cleaning the 
sample plate.
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To clean the sample plate using the deep cleaning procedure 

1. Prepare a 3% ammonium hydroxide/acetonitrile cleaning solution by mixing 450 mL of 
acetonitrile, 450 mL of water, and 100 mL of 30% ammonium hydroxide. Mix the 
solution well. 

You can prepare this solution in advance and store it in a glass container with a securely 
fitted screw cap.

2. Wet the plate surface with isopropyl alcohol while wiping the surface gently with a soft 
wipe. Repeat this step several times. 

3. Rinse the plate surface with methanol. 

4. Place the plate in a 1000 mL beaker or other suitable container, and add the cleaning 
solution prepared in step 1 until the plate is covered. 

5. Place the beaker in a sonicator. Cover the beaker with aluminum foil to prevent 
evaporation of the cleaning solution. 

6. Sonicate a fully immersed plate for 5 minutes. 

7. Using forceps, remove the plate from the cleaning solution, and place it in another 
container. Rinse several times with water to remove the cleaning solution. 

8. Rinse the plate thoroughly with methanol. 

9. Rinse the plate thoroughly with water.

10. Dry the plate completely with ultra high quality compressed air or ultra high quality 
nitrogen. 

11. Store the plate under vacuum for a few hours to ensure complete dryness. 

Drying the plate under vacuum is especially important when spotting calibration samples 
since the high organic content of the calibration mix can cause it to spread if the plate is 
not completely dry.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear safety glasses when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 

CAUTION  The sonicator (ultrasonic cleaner) must be approved for use with 
flammable vapors. Perform the sonication in a chemical fume hood.
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Assembling the Sample Plate

To reassemble the clean sample plate

1. Hold the base plate upside down. 

2. Pull the latch on the back of the base plate in the direction of the arrow. 

3. Fit the top plate snugly to the surface of the base plate. There must be no space between 
the top plate and the base plate. See Figure 31.

Figure 31. Sample plate assembly

4. Release the latch on the back of the plate. Do not touch the surface of the wells.

5. (Optional) Place an identifying label on the plate with a marker pen. Do not tape 
anything to the sample plate.

Base plate
Latch

Pull the latch under the
plate to fit the top plate

Top plate

Top plate fit snugly to the surface of the base plate

CAUTION  The top plate must be fit snugly to the base plate. Loading a misaligned 
plate assembly into the MALDI sample module can damage the MALDI source.

CAUTION  Do not tape anything to the sample plate. Loading sample plates with 
taped objects into the MALDI sample module can damage the MALDI source.
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Loading a Sample Plate into the MALDI Sample Module
Always use sample plates approved by Thermo Fisher Scientific. Make sure that you have 
assembled the sample plate correctly and have not taped anything to the plate before you load 
the plate into the MALDI sample module. A grinding noise coming from the MALDI sample 
module usually indicates that a sample plate is jammed somewhere in the XYZ mechanism. If 
this situation occurs, turn off the power to the LTQ XL mass spectrometer and contact 
Thermo Fisher Scientific Technical Support.

To load the sample plate into the MALDI sample module

1. Start Tune Plus:

a. From the LTQ workstation desktop, choose Start > All Programs > Xcalibur > 
LTQ Tune.

b. Or, double-click the  LTQ Tune shortcut icon on the computer desktop.

2. If there is currently a sample plate loaded in the MALDI source, remove it before 
proceeding. See “Removing a Sample Plate from the MALDI Sample Module” on 
page 56.

3. Make sure that there is no gap between the top plate and the base plate and that nothing 
is taped to the sample plate.

4. Insert the sample plate into the loading slot in the front of the MALDI sample module. 
The slot accepts the plate in one orientation only. Ensure that the top edge of the plate 
with the row of numbers engraved on it faces outward. See Figure 32. 

CAUTION  If you hear a grinding noise coming from the MALDI sample module and you 
suspect that a sample plate is jammed somewhere in the XYZ mechanism, turn off the 
power to the LTQ XL mass spectrometer.

CAUTION  Inserting a misaligned sample plate assembly or a sample plate assembly 
with anything extra attached to it, such as a piece of tape, can damage the MALDI 
source.
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Figure 32. Schematic of MALDI sample plate with arrows showing the orientation of plate 
loading

5. In the Tune Plus window, choose Setup > MALDI Source. 

The MALDI Source dialog box appears with the Control tab shown by default. See 
Figure 33.
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Figure 33. Control page of the MALDI Source dialog box

6. Click Insert Plate .

The Instrument Messages dialog box appears. This dialog box displays messages 
indicating the progress of the plate insertion; the MALDI source retracts the plate into 
the sample chamber, pumps the chamber down to operating pressure, and calibrates the 
plate position. The plate insertion process takes approximately two minutes to complete.

Insert plate button
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Figure 34 shows the series of messages that appear when you insert a plate into the 
MALDI sample module.

Figure 34. Instrument Messages dialog box during the plate loading process
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When the MALDI source completes the plate insertion process, this message appears (see 
Figure 35).

Figure 35. Query about keeping the current plate history

7. Do one of the following:

• If you want to keep the current plate history, click Yes. The Open dialog box appears. 
Select the appropriate file (*.MALDIPlate) and click Open.

• If you do not want to keep the current plate history, click No.

When the MALDI source completes the insertion process, the Instrument Messages 
dialog box displays the message shown in Figure 36. 

8. Click Close to close the dialog box.

Figure 36. Instrument Messages dialog box when plate insertion is complete

Removing a Sample Plate from the MALDI Sample Module
To remove the sample plate from the MALDI sample module

1. If Tune Plus is not running, start it by doing one of the following:

• From the LTQ workstation desktop, click the LTQ Tune  icon. 

• In the Instrument Setup window, choose LTQ > Start Tune Plus. 

2. Choose Setup > MALDI Source.

The MALDI Source dialog box appears. 
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3. If the Control page is not visible, click the Control tab. 

The MALDI source must be in Standby mode for the buttons at the top of the page to be 
available.

4. Click Eject Plate .

The dialog box shown in Figure 37 appears.

Figure 37. Prompt for saving history file

5. Do one of the following:

• To save a history file, click Yes. The Save As dialog box appears. Save the file with an 
appropriate name.

• To eject the plate without saving a history file, click No.

• To stop the plate ejection process, click Cancel.

6. Observe the messages displayed in the dialog box as the MALDI source goes through the 
ejection process. The plate ejection process usually takes between two and three minutes 
to complete. Figure 38 shows the instrument messages that appear during the injection 
process.
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Figure 38. Instrument messages that appear during the ejection process

When the ejection process is complete, the Instrument Messages dialog box displays the 
message shown in Figure 39.

Figure 39. Instrument Messages dialog box after plate ejection

7. Click Close to close the dialog box.

8. Remove the plate.
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Tuning and Calibrating in the MALDI Mode

This chapter describes how to tune and calibrate and test the sensitivity of the MALDI 
LTQ XL system. 

To tune and calibrate the LTQ XL mass spectrometer in the MALDI mode, perform these 
tasks:

1. Spot the calibrant/matrix mixtures on a plate that has been freshly cleaned for calibration. 

For information on preparing the calibration and sensitivity test targets, see the 
instructions sheet supplied in the Proteomass Calibration Kit or Appendix A, 
“ProteoMass Calibration Kit.”  

2. Load the spotted calibration plate into the MALDI sample module.

For information on loading the sample plate, see “Loading a Sample Plate into the 
MALDI Sample Module” on page 52.

3. Tune the laser energy to optimize ionization as described in “Tuning the Laser Energy 
with the Semi-Automatic Function” on page 70.

4. Obtain a quick spectrum of the calibration mix to ensure that all of the peptides are 
observed. 

5. With the tune file that contains the optimized laser energy open in the Tune Plus 
window, calibrate the mass spectrometer as described in “Calibrating the Mass 
Spectrometer” on page 76. 

IMPORTANT  These procedures use specially prepared calibrant/matrix mixtures. Before 
you spot the sample plate with the calibrant/matrix mixtures, ensure that the sample plate 
is clean and dry. To ensure dryness, store the sample plate under vacuum in the MALDI 
sample module until you are ready to spot the plate with the calibrant/matrix mixtures.

Contents

• Tuning on an Analyte

• Calibrating the Mass Spectrometer

• Checking the Sensitivity of the MALDI LTQ XL System

• Checking the Calibration
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Use the Check page of the Calibrate dialog box to check the calibration on your mass 
spectrometer once a month, and recalibrate if it does not pass the calibration check tests or if 
you notice a decrease in mass accuracy.

Tuning on an Analyte
This topic describes how to create a tune file for your analyte of interest. For the tuning and 
calibration procedure, the analyte of interest is the calibrant/matrix mixture prepared by 
following the procedure in “Preparing the Mass Calibration Targets” on page 170.

To create a tune file, follow these procedures:

1. Setting the LTQ XL Parameters for Tuning

2. Setting the MALDI Source Parameters for Tuning

3. Viewing Mass Spectra in the Tune Plus Window

4. Tuning the Laser Energy with the Semi-Automatic Function or Adjusting the Laser 
Energy Manually

Table 4 lists the parameters stored in a MALDI tune file.

Table 4. Parameters stored in a tune file  (Sheet 1 of 2)

Parameter Description

Optimal laser 
energy for a mass 
range

The laser energy focused on a target spot determines the number of 
ions that enter the ion trap. A laser energy that is too low causes a poor 
signal-to-noise ratio for the ions of interest. A laser energy that is too 
high can cause space charging. Space charging, which is caused by too 
many ions in the ion trap, can result in poor mass resolution and mass 
shifts.

Use the MALDI Source dialog box to set the laser energy.

AGC setting (On 
or Off ), including 
the number of 
laser shots with 
AGC Off

• With the AGC On option selected, the MALDI source uses a 
prescan to determine the number of laser shots per microscan. 

• With the AGC Off option selected, you manually set the number 
of laser shots. 

Use the MALDI Source dialog box, to turn AGC On or Off.
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Setting the LTQ XL Parameters for Tuning 

To set the LTQ mass spectrometer parameters for tuning and calibration 

1. Start Tune Plus:

a. From the computer desktop, choose Start > All Programs > Xcalibur > LTQ Tune.

b. Or, double-click the  LTQ Tune shortcut icon on the computer desktop.

The Tune Plus window appears (see Figure 40).

Number of 
microscans

A microscan is one mass analysis (ion injection and storage/scan out of 
ions followed by ion detection). Microscans are summed to produce 
one analytical scan. Summing microscans improves the signal-to-noise 
ratio of the mass spectral data. Increasing the number of microscans 
increases the time required to perform each scan.

Use the Define Scan dialog box to set the number of microscans. Set 
the number of microscans in the Define Scan dialog box to a multiple 
of the microscans/step (enabled when ASF is Off ) setting in the 
MALDI Source dialog box.

Number of sweep 
shots

The plate history file contains information about each sample spot, 
including a record of the fine positions within a sample spot that have 
been fired on by the laser. If the laser has not previously fired on a spot, 
the laser fires the specified number of sweep shots to remove 
contaminants from a spot. A sweep shot carries the same energy as a 
standard laser shot. 

Use the MALDI Source dialog box - Setup page to set the number of 
sweep shots.

Table 4. Parameters stored in a tune file  (Sheet 2 of 2)

Parameter Description
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Figure 40. Tune Plus window with a view of the LTQ XL mass spectrometer in Standby mode

2. On the Control/Scan Mode toolbar, click the On/Standby  button to take the 
mass spectrometer out of Standby mode. 

3. Open the default MALDI tune method:

a. Choose File > Open to display the Open dialog box.

b. Browse to the following folder:

C:\Xcalibur\methods

c. Select the Default_MALDI.LTQtune file or a tune file with an appropriate laser 
energy setting for the calibrant/matrix mixture. 

d. Click Open to open the file. 

The title bar displays the name of the tune file.

Standby/On button
Centroid/Profile button 

(data type)
Positive/Negative button 

(ion polarity mode)

Standby On
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4. On the Control/Scan Mode toolbar, ensure that the data type is  set to Profile. 

Because it retains resolution information, use the profile data type for MALDI. In profile 
mode, the peak has an area and a width. In centroid mode, the whole peak area is 
contained in a spike. Internal calculations by the program use centroid peaks regardless of 
the acquisition mode selected.

5. Click Positive/Negative  to switch the ion polarity mode to positive. 

6. Specify the scan parameters for the LTQ XL mass spectrometer:

a. Ensure that the advanced settings are turned on by choosing Scan Mode from the 
menu bar.

If the Advanced Scan Mode command in the drop-down menu has a check mark 
in front of it, the advanced settings are turned on. If not, choose Advanced Scan 
Mode to turn on the advanced settings. 

b. On the Control/Scan Mode toolbar, click Define Scan . 

The Define Scan dialog box appears. 

c. Set the parameters in the Define Scan dialog box. With the exception of the 
following settings, use the default settings. Figure 41 shows the settings for viewing 
the mass spectrum of the Normal Mass Range Calibration Mix.

Parameter Setting Result

Scan Description

Mass Range Normal Specifies that the scan range for this scan falls 
within the Normal mass range (m/z 50 to 2000). 

Scan Rate Normal Specifies Normal Scan Rate for this scan. 

Scan Type Full Specifies the Full scan type.

Scan Time

Microscans 2 Specifies 2 microscans per scan.

Scan Ranges

First Mass (m/z) 500.00 Specifies that the first mass in the scan range is 
m/z 500.00.

Last Mass (m/z) 2000.00 Specifies that the last mass in the scan range is 
m/z 2000.00.

Profile Centroid
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Figure 41. Define Scan dialog box with settings for MALDI tuning and calibration

d. Click OK to save the settings and to close the dialog box. 

After you finish setting the LTQ XL parameters, set the MALDI source parameters as 
described in the next topic.

Setting the MALDI Source Parameters for Tuning

With modifications, you can use the following procedure to tune on your analyte of interest. 
The analyte of interest for tuning and calibration is either the Normal Mass Calibration 
Mix/matrix mixture or the High Mass Calibration Mix/matrix mixture. Because the 
calibrant/matrix mixture contains a high concentration of each of the calibration peptides, the 
Automatic Gain Control (AGC) feature, which automatically determines the number of laser 
shots required for a target spot, is not used. AGC is a useful feature for low concentration 
samples.

To set the MALDI source parameter to tune on the calibrant/matrix mixture

1. In the Tune Plus window, choose Setup > MALDI Source.

The MALDI Source dialog box appears with the Control page shown by default. See 
Figure 42 on page 66.

2. Click the Control tab. 
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3. For the calibrant/matrix mixture, use the following settings. Figure 42 shows the MALDI 
Source - Control page settings for tuning on the calibrant/matrix mixture. Figure 43 
shows the Number Sweep Laser Shots setting. The laser energy setting for your MALDI 
LTQ XL system might differ.

4. Click Apply. 

Parameter Setting

MALDI Settings

Plate Motion CPS

ASF Off

Microscans per step 2

Laser Settings

Laser Energy current setting

AGC Off

Num Laser Shot 3

Number Sweep Laser Shots 
(MALDI Source - Setup page)

5 to 10

Note  Microscans per step are the number of microscans acquired at one crystal 
location before moving to a fresh MALDI crystal.

IMPORTANT  For best results when creating tune files for low concentration samples 
in the attomole (10-18) to femtomole (10-15) range, select the On option for AGC. 
For best results when creating tune files for samples in the picomole (10-12) to 
nanomole (10-9) range, select the Off option for AGC and manually set the number 
of laser shots.

IMPORTANT  Use laser sweep shots to remove contaminants from the target spots. 
Contaminants rise to the surface of target spots prepared with 
alpha-cyano-4-hydroxycinnamic acid (CHCA), the matrix used to prepare the 
calibrant/matrix mixtures.
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Figure 42. Control page of the MALDI Source dialog box
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Figure 43. Setup page of the MALDI Source dialog box

Use sweep laser shots to remove 
surface contaminants from target 
spots prepared with CHCA.
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Viewing Mass Spectra in the Tune Plus Window

Before you tune on an analyte or calibrate the mass spectrometer, view the mass spectrum of a 
test spot. 

The following procedure describes how to view the mass spectrum of the Normal Mass 
Calibration Mix/matrix mixture. For information on preparing samples for MALDI analysis, 
see Appendix B, “Sample Preparation.”  Adjust the LTQ XL and MALDI source parameters 
for your sample/matrix mixtures. 

To view a mass spectrum in the Tune Plus window

1. Prepare the Normal Mass Calibration Mix/matrix mixture and spot the target plate as 
described in “Preparing the Mass Calibration Targets” on page 170. 

2. Load the plate into the MALDI sample module as described in “Loading a Sample Plate 
into the MALDI Sample Module” on page 52.

3. Set the LTQ XL parameters as described on “Setting the LTQ XL Parameters for 
Tuning” on page 61. 

Adjust the parameters for your analyte.

4. Set the MALDI source parameters as described on “Setting the MALDI Source 
Parameters for Tuning” on page 64.

Adjust the parameters for your analyte.

5. In the MALDI Source dialog box, select a spot on the target plate that has a 
homogeneous coating of the calibrant/matrix. To select a target spot, click a sample spot 
on the sample position map. 

When you click a sample spot on the position map, the spot turns red. The sample plate 
moves so that the laser is positioned to fire at the selected sample spot, and the spot turns 
green.

6. Click  in the lower left corner of the MALDI Source dialog box. 

The laser begins firing and the LTQ XL mass spectrometer begins scanning. The laser 
takes approximately 15 seconds to begin firing after the MALDI source has been in 
Standby mode for more than 15 minutes.
 

7. Position the Control page so that you can observe it and the Tune Plus window 
simultaneously. 

8. On the File/Display toolbar in the Tune Plus window, click the  Display 
Spectrum View button to open the Spectrum view. 

9. Monitor the spectrum for the masses of interest. 
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When the MALDI LTQ XL system is mass analyzing the Normal Mass Range 
Calibration Mix/matrix mixture, you should see a mass spectrum consisting of the singly 
charged ions listed in Table 5.

Figure 44 shows the mass spectrum of the Normal Mass Calibration Mix.

Figure 44. Mass spectrum of the Normal Mass Calibration Mix

Table 5. Monoisotopic masses of the six peptides in the Normal Mass Range Calibration Mix

Peptide (M+H)+ Monoisotopic Mass

MRFA 524.27

Bradykinin 1-7 757.40

Bradykinin 1060.57

Angiotensin I 1296.69

Neurotensin 1672.92

Renin substrate 1758.93

MRFA Bradykinin 1-7

Bradykinin

Angiotensin I

Neurotensin

Renin substrate
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Tuning the Laser Energy with the Semi-Automatic Function

The laser energy is the most important parameter to tune with your MALDI source. Properly 
tuned laser energy is essential to obtaining high quality spectra. You do not need to tune the 
ion optics parameters, such as the multipole offset voltages and lens voltages. 

Optimize the laser energy with the analyte of interest and save the value in a tune file. For the 
Normal Mass Calibration procedure, create a tune file by tuning on the normal mass range 
calibration mix/matrix mixture. For the High Mass Calibration procedure, create a tune file 
by tuning on the high mass calibration mix/matrix mixture. The optimum laser energy for 
these two samples differs by a few microJoules.

Before you start the automated tune procedure, you must set the LTQ XL mass spectrometer 
scan parameters. During the semi-automatic laser energy optimization procedure, the 
MALDI program automatically sets the MALDI source parameters.

To tune the mass spectrometer 

1. Select a sample spot and view the mass spectrum as described in the previous topic 
“Viewing Mass Spectra in the Tune Plus Window.” 

2. In the Tune Plus window, choose Control > Tune.

The Tune dialog box appears with the Automatic tab shown by default.

3. Click the Semi-Automatic tab to open the Semi-Automatic page. See Figure 45.
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Figure 45. Semi-Automatic page of the Tune dialog box

4. In the What to Optimize list, select Laser Energy. 

5. Click Start to begin the tuning procedure. 

6. Observe the Tune Plus window and the Tune dialog box. 

While the tuning procedure is in progress, the Spectrum and Graph views display various 
tests and the Status box in the Tune dialog box displays status messages. 

When the system determines the optimal laser energy for the target sample, the Accept 
Optimized Value dialog box appears. See Figure 46.
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Figure 46. Accept Optimized Value dialog box with the new laser energy value

7. Click Accept to accept this laser energy value.

8. Save your tune method:

a. Choose File > Save As to open the Save As dialog box.

b. Browse to the following folder:

C:\Xcalibur\methods.

c. In the File name box, type a descriptive name for the file, such as 
MALDIMycCalTune or the date so that you can keep track of laser energy and 
conditions used on a specific day. See Figure 47.

Tune files have a LTQtune file extension.

Note  When the laser energy setting is optimized, the spectrum view displays all ions with 
a resolved isotopic pattern. The monoisotopic masses are within 0.15 to 0.20 u of the 
theoretical m/z for a particular peak (unless the mass calibration has shifted) and the 
signal-to-noise level for the mass peaks is reasonable. See Figure 44 on page 69.
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Figure 47. Save as file with a view of the Xcalibur\methods folder contents

d. Click Save to save the tune file.

The File Summary Information dialog box appears. See Figure 48.

Figure 48. File Summary Information dialog box 

e. In the Description box, type a description for the tune file, and then click OK to save 
the file and return to the Tune Plus window.

The accepted laser energy value is stored in the saved tune file.
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Adjusting the Laser Energy Manually

Correct adjustment of the laser energy is essential to obtain the best possible spectra with the 
MALDI source. If the laser energy is set too low, below the MALDI threshold, the laser 
desorbs primarily neutral molecules rather than ions, resulting in low signal or no signal. 
When the threshold level for ionization is achieved, analyte ions appear in the spectrum in 
amounts that increase with increasing laser energy. If the laser energy is set too high, the laser 
desorbs too many ions from the sample plate, including multiple clusters. This leads to high 
baseline, high chemical noise, and space charge effects. These in turn causes shifts in m/z that 
affect mass accuracy and reduce resolution. In addition, the higher the laser energy, the faster 
the consumption of sample. If you want to conserve sample, use the lowest laser energy setting 
that still gives good spectra.

The following procedures describes how to manually adjust the laser energy for the Normal 
Mass Calibration Mix/matrix mixture.

To adjust the laser energy manually

1. View the mass spectrum of the Normal Mass Calibration Mix/matrix mixture as 
described in “Viewing Mass Spectra in the Tune Plus Window” on page 68.

2. Monitor the spectrum for the masses of interest. 

When the MALDI LTQ XL system is mass analyzing the Normal Mass Range 
Calibration Mix, you should see a mass spectrum consisting of the singly charged ions 
listed in Table 5 on page 69. 

3. In the Control page, adjust the value in the Laser Energy (μJ) box to improve the signal 
according to guidelines given in Table 6.

Make initial adjustments in increments or decrements of 5, and then make finer 
adjustments in smaller increments. 

Table 6. Guidelines for MALDI laser power adjustment

Problem Solution

No signal Increase laser energy.

Low signal Increase laser energy.

High baseline Decrease laser energy.

High signal, low baseline, and poor mass 
resolution

Decrease laser energy in small increments.

High chemical noise Decrease laser energy.

Peak broadening and shifting to higher 
mass values (space charge effects)

Decrease laser energy.
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If your signal is weak or noisy, make sure that the calibration sample is fresh. If the calibration 
sample is fresh and you cannot improve the signal by adjusting the laser energy, try another 
sample spot. 

If the signal is too high, even when the laser energy is low, follow these steps to fix the 
problem:

1. Reduce the number of laser shots per spectrum: On the Control page of the MALDI 
Source dialog box, type or select a smaller value in the Num Laser Shot box. You can only 
access the Num Laser Shot box when AGC is Off.

2. If the signal is too strong, even with a single laser shot per spectrum, attenuate the ion 
beam by adjusting the front lens voltage:

a. Choose Setup > Ion Optics to display the Ion Optics dialog box.

b. Decrease the value in the Front Lens (V) box by 1 to 2 V. (Make the voltage more 
negative.)

c. Click Apply to apply the changes.

d. Observe the spectrum, and if necessary, make additional adjustments to the Front 
Lens voltage. 

e. Click OK to close the dialog box.

If you are not able to resolve the signal problems by taking these steps, consult the MALDI 
Source Hardware Manual for more information on diagnostics and troubleshooting, or 
contact technical support. 
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Calibrating the Mass Spectrometer 
Calibrating the mass spectrometer ensures that the mass assignments and the number of ions 
in the ion trap are correct. The semi-automatic calibration procedure calibrates all of the 
calibration parameters, such as the multipole RF frequency and the electron multiplier gain. 

If you want to calibrate the mass spectrometer in the high mass range, calibrate the normal 
mass range first, and then calibrate the high mass range. 

To calibrate the mass spectrometer, follow these procedures as necessary:

• Calibrating the Normal Mass Range

• Recalibrating a Failed Item

• Calibrating the High Mass Range

Calibrating the Normal Mass Range

To calibrate the normal mass range of the mass spectrometer automatically 

1. If you have not already done so, optimize the laser energy for the normal mass calibration 
sample (see “Tuning the Laser Energy with the Semi-Automatic Function” on page 70).

2. In the Tune Plus window, ensure that a tune file with an appropriate laser energy is open. 
The title bar displays the current tune file.

3. View the mass spectrum of the Normal Mass Calibration Mix/matrix mixture (see 
“Viewing Mass Spectra in the Tune Plus Window” on page 68).

4. When you observe a stable mass spectrum, choose Control > Calibrate. 

The Calibrate dialog box appears with the Automatic page shown by default. 

5. Click the Semi-Automatic tab.

The Semi-Automatic page appears (see Figure 49).
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Figure 49. Semi-Automatic page of the Calibrate dialog box

6. For the Mass Range, select the Normal option.

7. To select all items for calibration, select the Select All check box.

8. To start the semi-automatic calibration procedure, click Start. 

The program automatically downloads the appropriate scan settings for the normal mass 
range to the mass spectrometer, and the mass spectrometer uses the laser energy specified 
in the current tune file.

9. Observe the Tune Plus window and the Calibrate dialog box. 

While calibration is in progress, the Spectrum and Graph views display a variety of test 
results, and the Status box of the Calibrate dialog box displays status messages. 

The calibration procedure takes approximately 30 minutes to complete. 
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When the calibration procedure finishes, the Instrument Messages dialog box appears and 
indicates whether the calibration for each item was successful. If the calibration for an 
item is successful, the mass spectrometer saves the new calibration parameter 
automatically to the master calibration file on the hard disk.

10. If the calibration for a particular item fails, try recalibrating on that item individually as 
described in the next topic, “Recalibrating a Failed Item.”  Before recalibrating, check the 
spectrum again to make sure that all ions in the calibration mix are present with adequate 
signal-to-noise ratios.

Recalibrating a Failed Item

To recalibrate a failed item 

1. In the MALDI Source dialog box, Control page, select a new spot as necessary.

2. In the What to Calibrate list, select only the check box next to the item you want to 
recalibrate. 

3. Click Start to recalibrate the selected parameters. 

4. Repeat step 1 to step 3 until all calibration items have passed. 

When all calibration items are successful, your mass spectrometer is properly calibrated in the 
normal mass range. 

Calibrating the High Mass Range

Before you operate the mass spectrometer in the high mass range (up to 4000 u), calibrate the 
mass spectrometer in the high mass range. 

To calibrate the high mass range of the mass spectrometer 

1. Prepare the High Mass Calibration Mix/matrix mixture and spot the target plate (see 
“Preparing the Mass Calibration Targets” on page 170). 

2. Load the plate into the MALDI sample module (see “Loading a Sample Plate into the 
MALDI Sample Module” on page 52).

3. Open a tune file with an appropriate laser energy, or optimize the laser energy for the 
high mass calibration sample (see “Tuning the Laser Energy with the Semi-Automatic 
Function” on page 70).

Note  When you operate the MALDI LTQ XL system in the high mass range, you might 
observe artifact peaks. These peaks are produced when some ions of a particular m/z are 
held in the ion trap and ejected later. This produces an artifact peak at a higher m/z value 
than the true m/z value of the ions. When seen, these artifact peaks are typically present at 
low intensities and cannot be isolated or fragmented.
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4. View the mass spectrum of the High Mass Calibration Mix/matrix mixture:

a. Set the LTQ XL parameters as described on “Setting the LTQ XL Parameters for 
Tuning” on page 61. with the following exceptions: select High in the Mass Range 
list and type 4000 in the Last Mass (m/z) box.

b. Set the MALDI source parameters as described on “Setting the MALDI Source 
Parameters for Tuning” on page 64.

c. In the MALDI Source dialog box, select a spot on the target plate that has a 
homogeneous layer of the calibrant/matrix.

d. Click the On/Standby  button at the lower-left corner of the MALDI Source 
dialog box. 

The laser begins firing. 

e. On the File/Display toolbar in the Tune Plus window, click the Display Spectrum 
View button to open the Spectrum view. 

5. Monitor the spectrum for the masses of interest.

The High Mass Calibration Mix contains the five peptides listed in Table 7.

Figure 50 shows the mass spectrum of the peptides in the High Mass Calibration Mix.

Table 7. Monoisotopic masses of the five peptides in the High Mass Range Calibration Mix

Peptide (M+H)+ Monoisotopic Mass

MRFA 524.27

Bradykinin 1060.57

ACTH 1-16 1936.99

Melittin 2845.75

ACTH 7-38 3657.93
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Figure 50. Mass spectrum of the High Mass Calibration Mix

6. When you observe a stable mass spectrum, choose Control > Calibrate to open the 
Calibrate dialog box. 

7. For the Mass Range, select the High option. 

The High Mass Range Calibration page appears. See Figure 51.

MRFA

Bradykinin

ACTH 1-16

Melittin

ACTH 7-38
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Figure 51. Calibrate dialog box with the parameters for high mass range calibration

8. In the What to Calibrate column, select the Select All check box.

9. Click Start to begin the high mass calibration procedure. 
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Checking the Sensitivity of the MALDI LTQ XL System
You can check the sensitivity of the MALDI LTQ XL system by evaluating the signal-to-noise 
ratio of the 1046 m/z peak for a 1 fmol angiotensin II target spot. 

To test the sensitivity of the MALDI LTQ XL system

1. Specify the acquisition parameters for the LTQ XL mass spectrometer:

a. Start Tune Plus.

b. On the Control/Scan Mode toolbar, click the On/Standby  button to 
switch the mass spectrometer from Standby to On. 

c. If you have not already done so, create a tune file for angiotensin II. For instructions 
on tuning the mass spectrometer for a specific analyte, see “Tuning on an Analyte” 
on page 60.

d. On the Control/Scan Mode toolbar, click Centroid/Profile  to switch the data 
type to profile. 

e. Click Positive/Negative  to switch the ion polarity mode to positive. 

f. On the Control/Scan Mode toolbar, click Define Scan . 

The Define Scan dialog box appears. 

g. With the exception of the following settings, use the default settings in the Define 
Scan dialog box. 

Parameter Setting Result

Scan Description

Mass Range Normal Specifies that the scan 
range for this scan falls 
within the Normal mass 
range (m/z 50 to 2000). 

Scan Rate Normal Specifies Normal Scan 
Rate for this scan. 

Scan Type Full Specifies the Full scan 
type.

Scan Range

First Mass (m/z) 500.00 Specifies that the first 
mass in the scan range is 
m/z 500.00.

Last Mass (m/z) 2000.00 Specifies that the last mass 
in the scan range is 
m/z 2000.00.
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2. Specify the acquisition parameters for the MALDI source:

a. In the Tune Plus window, choose Setup > MALDI Source. 

The MALDI Source dialog box appears.

b. Click the Setup tab. 

c. With the exception of the settings specified in the following table, use the default 
settings on the Setup page of the MALDI Source dialog box. 

Use the Semiautomatic page of the Tune dialog box to determine the optimal laser 
energy for the angiotensin II target spots. For information on optimizing the laser 
energy, see “Tuning the Laser Energy with the Semi-Automatic Function” on 
page 70.

d. Click Apply. 

e. Click the Acquire tab.

f. Specify an appropriate file name and folder for the raw data file.

g. In the Acquisition mode area, type 10 in the Number Scan box.

h. Make sure that the Go to Standby when Finished check box is clear.

3. Insert the target plate with the sensitivity target spots into the MALDI sample module.

For information on preparing the sensitivity targets, see “Preparing the Sensitivity Test 
Targets” on page 173. For information on loading a sample plate, see “Loading a Sample 
Plate into the MALDI Sample Module” on page 52.

4. Acquire data at several positions within the well spot.

Parameter Setting

Sampling pattern settings

Plate Motion Manual

Option check box Cleared

ASF Spectrum Filer (ASF)

Off

ASF Off Settings

Microscans per step 5

Laser Settings

AGC Off

Number Laser Shots Per 
Microscan

5

Laser Energy Varies (30 to 50)

Number Sweep Laser Shot 5
hermo Scientific MALDI Source Getting Started Guide 83



5 Tuning and Calibrating in the MALDI Mode
Checking the Sensitivity of the MALDI LTQ XL System

84
For information about acquiring sample data in Tune Plus, see Chapter 6, “Acquiring 
Sample Data in Tune Plus.” 

5. Review the raw data file in Qual browser. See Figure 52.

The intensities of the noise peaks on either side of the 1046 m/z peak should be no greater 
than one-tenth the intensity of the 1046 m/z peak.

Figure 52. Qual Browser with a raw data file acquired from an angiotensin II target spot
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Checking the Calibration
To verify the performance of the mass spectrometer, check the calibration periodically. 
Checking the calibration does not update the calibration settings in the master calibration file. 
The date stamp of the master calibration file changes when you perform a calibration check 
because the master calibration file stores a record of the calibration check.

Because the mass spectrometer performs an internal calibration check of the multipole RF 
frequency and the main RF frequency, these calibration checks do not require external 
calibration samples. The Normal Mass Calibration Mix/matrix mixture is used for the rest of 
the calibration checks.

To perform a calibration check

1. Prepare the Normal Mass Calibration Mix/matrix mixture and spot the target plate as 
described in “Preparing the Mass Calibration Targets” on page 170. 

2. Load the plate into the MALDI sample module as described in “Loading a Sample Plate 
into the MALDI Sample Module” on page 52.

3. View the mass spectrum of the Normal Mass Calibration Mix/matrix mixture:

a. Set the LTQ XL parameters as described in “Setting the LTQ XL Parameters for 
Tuning” on page 61.

b. Set the MALDI source parameters as described in “Setting the MALDI Source 
Parameters for Tuning” on page 64.

c. In the MALDI Source dialog box, select a spot on the target plate that has a 
homogeneous coating of the calibrant/matrix.

d. Click  to turn on the MALDI laser.

e. Observe the Spectrum view in Tune Plus. 

4. In the Tune Plus window, choose Control > Calibrate. 

The Calibrate dialog box appears. 

5. Click the Check tab.

The Check page appears. See Figure 53.

6. Select the check boxes for the calibration parameters of interest, and then click Start.
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Figure 53. Check page of the Calibration dialog box
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Acquiring Sample Data in Tune Plus

This chapter describes how to view and acquire mass spectral data in Tune Plus. When you 
acquire sample data using Tune Plus, you can set the data acquisition parameters in an 
interactive manner or use a stored instrument method. 

For information on creating instrument methods, see “Creating an Instrument Method” on 
page 105.

Acquiring Sample Data Interactively in Tune Plus 
This procedure shows typical settings for acquiring mass spectral data on a BSA digest/DHB 
matrix sample in the positive ion polarity mode and the high mass range with the MALDI 
LTQ XL system. 

To acquire data interactively in Tune Plus, follow these procedures:

1. Setting the LTQ XL Parameters for Sample Data

2. Setting the MALDI Source Parameters

3. Acquiring a Raw Data File in Tune Plus

Setting the LTQ XL Parameters for Sample Data

To set the LTQ XL mass spectrometer parameters 

1. Start Tune Plus:

• From the LTQ workstation desktop, choose Start > All Programs > Xcalibur > 
LTQ Tune.

• Or, double-click the  LTQ Tune shortcut icon on the computer desktop.

Contents

• Acquiring Sample Data Interactively in Tune Plus

• Using an Instrument Method to Acquire Sample Data in Tune Plus

• Setting Up to Acquire MS/MS Data
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The Tune Plus window appears (see Figure 40 on page 62). 

2. On the Control/Scan Mode toolbar, click the On/Standby  button to switch the 
mass spectrometer from Standby to On. 

3. Open a MALDI tune method:

a. Choose File > Open to display the Open dialog box.

b. Navigate to and select the tune file you created in “Tuning the Laser Energy with the 
Semi-Automatic Function” on page 70. 

c. Click Open to open the file. 

4. On the Control/Scan Mode toolbar, click the Centroid/Profile  button to switch the 
data type to profile. 

5. Click the Positive/Negative  button to switch the ion polarity mode to positive. 

6. Specify the scan parameters for the mass spectrometer:

a. On the Control/Scan Mode toolbar, click the Define Scan  button to 
open the Define Scan dialog box. 

b. With the exception of the settings listed in the following table, use the default 
settings in the Define Scan dialog box. Figure 54 shows the parameters settings for 
the Define Scan dialog box. 

Parameter Setting Result

Scan Description

Mass Range High Specifies that the scan range for this 
scan falls within the High mass range 
(m/z 100 to 4000). 

Scan Rate Normal Specifies Normal Scan Rate for this 
scan. 

Scan Type Full Specifies the Full scan type.

Scan Ranges

First Mass (m/z) 700.00 Specifies that the first mass in the scan 
range is m/z 700.00. ‘First Mass’ values 
for protein digest samples of 600 to 
800 are common in a MALDI scan 
range, depending on the matrix used. 
For calibration mix use a value of 500. 
For small molecules adjust 
accordingly.

Last Mass (m/z) 3000.00 Specifies that the last mass in the scan 
range is m/z 3000.00.

Microscans Varies Use 2 to 3 or more if needed.
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Figure 54. Define Scan dialog box with settings for data acquisition in the Full scan mode

c. Click OK to save the settings and close the dialog box. 

You have now finished setting the LTQ XL mass spectrometer parameters. Continue to the 
next topic, which shows you how to set the MALDI source parameters in the Tune Plus 
window. 

Setting the MALDI Source Parameters

The next step in acquiring data with the MALDI LTQ XL system is to set the parameters for 
the MALDI source. 

To set the MALDI parameters in Tune Plus

1. In the Tune Plus window, choose Setup > MALDI Source. 

The MALDI Source dialog box appears with the Control page shown by default.
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2. Use the information in Table 8 to set the parameters for the MALDI source. 

For a BSA digest/DHB matrix mixture, Figure 55 shows typical Control page settings 
and Figure 56 shows typical Setup page settings. For information on determining the 
optimal laser energy for your samples, see “Adjusting the Laser Energy Manually” on 
page 74.

Table 8. Typical MALDI source settings based on the matrix compound 

Parameters DHB matrix CHCA matrix

Laser energy (μJ) 20 (approximately 15 to 
20 μJ higher than for 
CHCA)

5

Number Laser Shots 
(with AGC in the Off mode)

3 to 5 3 to 5

Number Sweep Laser Shots
(Setup page)

0 to 3 3 to 5

ASF On settings 

Microscans per Step for ASF Off
(This setting must be a multiple 
of the Microscans setting in the 
Define Scan dialog box)

3 3

Threshold type (Setup page) Peak height

MS threshold (Setup page) ≥5000 ≥5000

MS2 threshold (Setup page) 300 to 1000 300 to 1000
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Figure 55. Control page with settings for a BSA digest/DHB matrix sample
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Figure 56. Setup page with typical settings for a BSA digest/DHB matrix sample

3. Click Apply. 

You have now set the MALDI parameters for data acquisition. With the MALDI Source 
dialog box open, go to the next topic, “Acquiring a Raw Data File in Tune Plus.” 
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Acquiring a Raw Data File in Tune Plus

To acquire data in Tune Plus

1. Ensure that the On/Standby button on the Tune Plus toolbar is set to On , and 
that the MALDI Source dialog box is open.

2. In the MALDI Source dialog box, click the Acquire tab.

The Acquire page appears (see Figure 57).

3. Select a well plate spot by clicking a spot in the sample position map at the bottom of the 
MALDI Source dialog box.

The X-Y mechanism of the MALDI source moves the sample plate to position the laser 
over the requested sample position. After you select it, the position is highlighted in red 
until the plate moves to the specified position. Then the position is highlighted in green. 

4. Specify the file location and file name:

• Select the file folder by clicking  and browsing to the appropriate directory.

• Specify the file name by typing a name in the File name box.

Three separate boxes separated by underscores constitute the file name: the base file 
name box, the sample position box, and the suffix box. The program automatically 
fills in the sample position box with the current well plate location and the suffix box 
with a date stamp.

• (Optional) In the Sample Name box, type the sample name. 

• (Optional) In the Comment box, type additional comments about the sample or 
experiment. 

5. Under Acquisition mode, select the Number Scan option and type a value for the 
number of scans to be collected per data file in the adjacent box.
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Figure 57. Acquire page

6. Click the  button at the lower-left corner of the MALDI Source dialog box. 

The laser begins firing, and the mass spectrum appears in the Tune Plus window. 

Note  The LTQ XL mass spectrometer and the MALDI source have their own 
independent On/Standby or On/Off buttons. 

The LTQ On/Standby  button is located in the Tune Plus toolbar. Clicking this 
button places the LTQ XL mass spectrometer in the On mode, making it ready to 
acquire data. The MALDI source switches from the Off mode to the Standby mode. 

The MALDI source (Turn on/Turn off MALDI source)  button is located at the 
lower-left corner of the MALDI Source dialog box. Clicking this button starts the 
laser firing. 

For more information on the operation modes for the MALDI source, see “Placing 
the MALDI Source in the On Mode” on page 36.

Well plate location
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7. Click the Start/Stop Acquisition  button at the bottom of the MALDI Source dialog 
box to turn on the MALDI source and begin saving data to the specified file. 

The instrument continues to acquire data and save it to the specified file until you click 
the Start/Stop Acquisition  button again or it acquires the specified number of scans 
per file. The data file is stored in the specified folder and has a .raw file extension.

Using an Instrument Method to Acquire Sample Data in Tune Plus
Before you use an instrument method to acquire a sequence of data files in Xcalibur Sequence 
Setup, you can test the method by acquiring a sample data file in Tune Plus.

To use a stored instrument method to acquire sample data in Tune Plus

1. Start Tune Plus:

• From the LTQ workstation desktop, choose Start > All Programs > Xcalibur > 
LTQ Tune.

• Or, double-click the  LTQ Tune shortcut icon on the computer desktop.

2. On the Control/Scan Mode toolbar, click the On/Standby  button to switch the 
mass spectrometer from Standby to On. 

3. In the Tune Plus window, choose Setup > MALDI Source. 

The MALDI Source dialog box appears with the Control tab shown by default.

4. Click the Acquire tab.

The Acquire page appears.

5. Make the appropriate entries and selections for the data file location and name (see step 4 
on page 93).
hermo Scientific MALDI Source Getting Started Guide 95



6 Acquiring Sample Data in Tune Plus
Using an Instrument Method to Acquire Sample Data in Tune Plus

96
6. Select the Use Instrument method check box, and then select an instrument method (see 
Figure 58).

Figure 58. Acquire page with selected instrument method

7. Click Apply (at the bottom of the MALDI Source dialog box).

8. To start data acquisition, click .

The laser starts firing. The system starts scanning and acquiring data (based on the 
settings in the instrument method) to an Xcalibur raw data file. When the system 
completes the instrument method, the MALDI source returns to the Off mode.

Note  Selecting the Go to Standby when Finished check box places the 
LTQ XL mass spectrometer in Standby mode at the end of data acquisition. 
When the LTQ XL mass spectrometer is in Standby mode, the high voltages and 
nitrogen gas flow are Off.
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Setting Up to Acquire MS/MS Data
Before you perform full-scan MS/MS experiments, for best results, optimize the isolation 
width and the relative collision energy parameters for your analytes. You visually determine an 
appropriate isolation width to ensure the effective isolation of the ion of interest, and then 
you optimize the relative collision energy to ensure efficient fragmentation of the parent ion 
(precursor ion). The relative collision energy for a particular analysis depends on the type of 
sample you are analyzing. You can optimize the collision energy manually or use the 
automated process provided by the program.

To determine an appropriate isolation width and optimal collision energy for the ions of 
interest, follow these procedures: 

1. Determining the Optimum Isolation Width

2. Manually Optimizing the Collision Energy

3. Automatically Optimizing the Collision Energy

Determining the Optimum Isolation Width 

For this experiment, and for most applications, use the default settings for the advanced scan 
features, Activation Q and Activation Time. For more information about these parameters, 
refer to the Help. The Activation Q and Activation Time parameters appear in the Define 
Scan dialog box when you choose Scan Mode > Advanced Scan Features.

To manually optimize the isolation width for an MS/MS experiment

1. From the Tune Plus window, click the On/Standby button to take the MS detector out 
of Standby mode and turn it on.

2. Ensure that the Profile  data type is selected. 

3. Set the scan parameters to acquire full-scan MS/MS data for your analyte of interest:

a. Click the Define Scan  button. 

The Define Scan dialog box appears. Figure 59 shows the scan settings for the 
1881.7 m/z precursor ion in a BSA digest/DHB matrix sample.

b. Ensure that the Parent Mass box contains the correct m/z value and that the scan 
range is appropriate.

c. Ensure that the value in the Normalized Collision Energy column is set to 0.

On Standby
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Figure 59. Define Scan dialog box with initial settings to optimize the isolation width for m/z 1881.7

4. In the MSn Settings area of the Define Scan dialog box, type 3.0 to specify an isolation 
width of m/z 3.0 in the Isolation Width column, and then click Apply. Do not close the 
Define Scan dialog box. 

5. In the Tune Plus window, observe the mass spectrum for the parent ion of your analyte. 
Ensure that the readback value for the normalized intensity (NL) is relatively stable.

6. Repeat step 4 and step 5, entering successively smaller values for the isolation width. 
Continue to observe the intensity of the mass spectrum of the parent ion, and ensure that 
the value for the normalized intensity (NL) is stable with each change you make to the 
isolation width.

Scan Range

Parent Mass (precursor)

Normalized Collision Energy

Note  The optimum value for the Isolation Width is the smallest m/z width that gives 
a mass spectrum of maximum intensity for only the ions of interest. When the 
optimum Isolation Width is obtained, the value for the normalized intensity (NL) in 
the mass spectrum display is stable, and the mass peak for the parent ion is at its 
maximum intensity and appears symmetrical. An Isolation Width value that is less 
than the optimum value causes a substantial drop in the NL reading. A significant 
drop in sensitivity indicates that the ions of interest are not effectively isolated.
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Figure 60 shows the MS/MS precursor isolation spectra isolation widths of 1 and 3.

Figure 60. MS/MS spectrum for m/z 1881.7 with an isolation width of 3 (collision energy = 0)
)

Note  The optimal isolation width is typically between 1 to 3. After you optimize the 
isolation width, you can compensate for minor changes in tune stability by increasing 
the isolation width value a small amount. This adjustment should be no larger than 
m/z = 1. 

Isolation width = 3

Isolation width = 1

1880.73
1881.64

1882.55
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Manually Optimizing the Collision Energy

To manually optimize the collision energy

1. In the Tune Plus window, ensure that the MS detector is in the On mode.

2. Ensure that the  Profile data type is selected. 

3. Click the Define Scan  button to open the Define Scan dialog box.

4. Set the scan parameters for your analyte of interest. You must type a value for the parent 
mass in the Parent Mass box in the MSn Settings area. See Figure 61.

Figure 61. Define Scan dialog box with typical settings for acquiring full-scan MS/MS data

5. In the Normalized Collision Energy box under MSn Settings, type or select 35. 

6. Click Apply.

7. In the Tune Plus window, observe the mass spectrum of the product ions of your analyte 
of interest. 

Figure 62 shows the MS/MS spectrum for the m/z 1881.7 precursor ion.

Beginning Normalized Collision Energy setting
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Figure 62. MS/MS spectrum for the m/z 1881.7 precursor ion

8. If necessary, increase the value for the normalized collision energy in increments of 5% 
and click Apply, until the intensity of the precursor ion is less than 5% of the intensity of 
the product ions.

Automatically Optimizing the Collision Energy

The optimum relative collision energy maximizes the product ion intensity. 

To automatically optimize the relative collision energy for an analyte of interest 

1. When you have clearly identified a mass-to-charge ratio of a product ion for your analyte 
of interest, click the Tune  button. 

The Tune dialog box appears with the Automatic tab shown by default.

2. Click the Collision Energy tab. 

The Collision Energy page appears (see Figure 63).
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Figure 63. Collision Energy page 

3. Select the Product Ion Mass option.

4. In the Product Ion Mass box, type a value for one of the product ions of your analyte. 

5. Click Start to start the optimization procedure. 

6. In the Spectrum view of Tune Plus, observe the full-scan MS/MS spectrum of your 
analyte of interest. 

When the collision energy is optimized, the Accept Optimized Value dialog box appears. 
See Figure 64.
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Figure 64. Accept Optimized Value dialog box

7. Click Accept to accept the new collision energy value and return to Tune Plus. 

The new value appears in the Define Scan dialog box.

8. Click Cancel to close the Tune dialog box. 

After you optimize the relative collision energy, the MALDI LTQ XL system is ready to 
acquire MS/MS data on your analyte of interest.
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Automatically Acquiring Sample Data with Xcalibur

This chapter describes how to automate data acquisition for a set of samples analyzed with the 
MALDI LTQ XL system.

When you automate data acquisition with the Xcalibur data system, you create an instrument 
method specifying how the instrument collects spectra, and an acquisition sequence 
specifying which sample positions are to be examined and where the data is to be stored. 

The procedures in this chapter describe how to set up a data-dependent MS/MS experiment 
that can be used to identify the components of an enzyme digest. Refer to Xcalibur Help for 
more information on how to customize the Instrument Setup and Sequence Setup parameters 
for your experiment. 

Creating an Instrument Method
The instrument method defines the experimental parameters for data acquisition. When you 
use Xcalibur to acquire data, you select an instrument method for each sample that you run in 
the Sequence Setup view. You can also use instrument methods in Tune Plus.

This procedure describes how to create an instrument method with the Nth Order Double 
Play template. This template is useful for setting up an experiment in which you acquire 
MS/MS data for the most intense precursor peaks in the MS spectrum. 

When you create an instrument method, you import a tune file for your analytes of interest. 
The tune file becomes part of the method and contains parameters that optimize the ion 
transmission for your analytes. For information on creating a tune file for your analytes, see 
“Tuning on an Analyte” on page 60.

Contents

• Creating an Instrument Method

• Creating an Acquisition Sequence

• Acquiring Raw Data Files in Sequence Setup
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To set up an instrument method based on the Nth Order Double Play template

1. Open the Instrument Setup window:

a. From the taskbar, choose Start > All Programs > Xcalibur > Xcalibur. 

The Xcalibur Home Page - Roadmap view appears. 

b. In the Roadmap view, click the Instrument Setup  button.

The Instrument Setup window appears. 

2. In the left pane of the Instrument Setup window, click the LTQ MS  button.

The New Method page appears. See Figure 65.

Figure 65. New Method page with the list of templates for the LTQ XL MS

The remaining steps in this procedure describe how to set up an Nth order double play 
experiment suitable for an enzyme digest. 

3. Click Nth order double play.
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The Nth Order Double Play dialog box appears (see Figure 66).

Figure 66. Nth Order Double Play dialog box with the default setting of 1

4. In the Analyze top N peaks box, type or select 50. 

When you run this experiment, the MALDI LTQ XL acquires data on the 50 most 
intense peaks in the mass spectrum.

5. Click OK.

The template for an Nth Order Double Play experiment appears. 

For the purpose of this tutorial, use the default settings in the Nth Order Double Play 
template with the exception of the parameters listed in the following table and shown in 
Figure 67.

Parameter Setting Result

Acquisition Mode

Number of 
Experiments to 
Acquire

1 The system performs one acquisition 
experiment.

Experiment 
Settings

Tune method The tune file for 
the analyte of 
interest

The tune file contains the parameters listed 
in Table 4 on page 60.

Scan Event 1 
Settings

Scan Description

Mass Range High The scan range for this scan falls within the 
high mass range. 

Data type Profile The scan collects Profile data.

Scan Ranges

First Mass (m/z) 800.00 Sets the first mass in the scan range to 
800.00. 

Last Mass (m/z) 4000.00 Sets the last mass in the scan range to 
4000.00. 
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Figure 67. Nth Order Double Play page with the Scan Event 1 settings

6. To select a tune file, click the button to the right of the Tune method box, browse to 
the directory where you stored the tune file, and double-click the appropriate *.LTQtune 
file.

7. Set up the dependent scan parameters for Scan Event 2:

a. Click Scan Event 2 to display the Scan Event 2 Settings area in the bottom portion 
of the window. See Figure 68.

b. Select the Wideband Activation check box. 

Selecting the wideband activation check box increases the amount of fragmentation 
during mass analyzer collision-induced dissociation (CID).

Settings for 
Scan Event 1

Tune file
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Figure 68. Nth Order Double Play page with the Scan Event 2 settings

c. Click Settings. 

The Data Dependent Settings dialog box appears. 

d. In the list on the left side of the dialog box, select Dynamic Exclusion.

The Dynamic Exclusion page appears (see Figure 69). 

e. Select the Enabled check box.

Settings for 
Scan Event 2

Wideband Activation check box
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f. With the exception of the High value, use the default settings in the Dynamic 
Exclusion page. See the following table and Figure 69. 

The exclusion mass width of 1.50 to 4.00 ensures that the mass spectrometer does 
not perform an MSn experiment on both the monoisotopic and most intense isotope 
peaks in the MS spectrum.

 

Figure 69. Dynamic exclusion settings

g. Under Experiment, select Charge State to open the Charge State page. Then select 
the Enable charge state screening check box. See Figure 70.

Parameter Setting Result

Enabled This scan uses the Dynamic Exclusion feature.

Exclusion Mass Width

Low 1.50 An ion does not trigger a dependent scan if its mass 
falls within a range of 1.50 m/z units less than a mass 
on the exclusion list. 

High 4.00 An ion does not trigger a dependent scan if its mass 
falls within a range of 4.00 m/z units greater than a 
mass on the exclusion list. 
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Figure 70. Charge State settings

h. Under Scan Event, select Current Scan Event to open the Current Scan Events page. 
With the exception of the setting listed in the following table, use the default settings 
on the Current Scan Events page. Figure 71 shows typical settings for the parameters 
in the Current Scan Events page.

Parameter Setting Result

Minimum signal 
threshold (counts)

300 Signals above 300 counts trigger 
MS/MS. Values from 100 to 
500 are common. If an 
experiment quits before 
collecting all the MS/MS you 
expect, the threshold might be 
set too high.
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Figure 71. Current Scan Event settings

i. Under Scan Event, select Activation to display the Activation page. With the 
exception of the settings listed in the following table, use the default settings. 
Figure 72 shows typical settings for the Activation page. 

Parameter Setting Result

Default charge state 1 The default charge state 
for this scan is 1.

Isolation Width 
(m/z)

3.0 The isolation width for 
this scan is m/z 3.0

Normalized 
Collision Energy

The default setting is 35.  Use the normalized 
collision energy value 
determined by following 
the procedure in “Setting 
Up to Acquire MS/MS 
Data” on page 97.
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Figure 72. Activation settings

8. Click OK to close the Data Dependent Settings dialog box.

9. Choose File > Save As to save your instrument method file. 

10. In the File name box, type a descriptive file name for your instrument method.

11. Click Save.

The File Summary Information dialog box appears.

12. Type a comment in the Comment box, and then click OK to save the instrument 
method and close the dialog box.

Instrument method files have the file extension .meth.

Creating an Acquisition Sequence
Creating an acquisition sequence allows you to keep all the data you collect from a single 
sample plate together and organized. The sequence (*.sld) file you create stores the data file 
path and the location on the plate for each sample, plus the sample name and any comments 
you add. 

To create an acquisition sequence 

1. Open Xcalibur by choosing Start > All Programs > Xcalibur > Xcalibur. 

2. On the Xcalibur Home Page - Roadmap view, click the Sequence Setup  button.

The Sequence Setup Home Page window appears. 
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3. Choose File > New. 

The New Sequence Template dialog box appears. See Figure 73.

Figure 73. New Sequence Template dialog box

4. Fill in the parameters in the General area:

a. In the Base File Name box, type a base file name. 

Xcalibur appends a suffix to this base file name to create a data file name for each 
sample in the sequence. 
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b. In the Path box, select a directory path for storing your data files.

c. Click Browse next to the Instrument Method box. Locate and open the instrument 
method that you created in the previous procedure, “Creating an Instrument 
Method.”  

d. Do not specify a processing method or a calibration file (leave these selections blank) 
unless you want the program to process the raw data files as it acquires them. You do 
not need a processing method or a calibration file to acquire raw data files. 

For information on creating processing methods and calibration files, refer to the 
Xcalibur data system Help.

5. Select the sample positions:

a. In the Samples area, click Select Vials. 

The MALDI - Select Sample Spots dialog box appears. See Figure 74.

Figure 74. MALDI – Select Sample Spots dialog box

b. Select the positions in which you have placed samples on the plate. Click individual 
positions to select them, or click and drag over a range to select a range of positions. 

c. Click OK to close the MALDI - Select Sample Spots dialog box.

6. If you are using this sequence to acquire data files (rather than acquire and process, or 
process only), use the default settings for the rest of the parameters in the New Sequence 
Template dialog box.

7. Click OK. 

Note  Data acquisition proceeds by rows rather than by columns.
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A sample list appears in the Sequence Setup window. See Figure 75.

Figure 75. Xcalibur Sequence Setup view with a typical MALDI acquisition sequence 

8. To display more columns, change the column arrangement:

a. Click the Column Arrangement  button on the toolbar. 

The Column Arrangement dialog box appears. See Figure 76.

Figure 76. Column Arrangement dialog box with the columns used for a MALDI sequence

b. In the Available Columns list, select the columns of interest and click Add to add 
them to the Displayed Columns list. 
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c. When you have added the columns of interest, click OK. 

9. Save the sequence:

a. Choose File > Save to display the File Summary Information dialog box. 

b. Type a description or summary of the sequence in the Description box, and then 
click OK.

The Save As dialog box opens. 

c. Specify the path and file name for the acquisition sequence and click Save. 

The file extension for sequence files is .sld.

The Acquisition Sequence is now saved. You are ready to run the sequence and acquire data. 
With the Acquisition Sequence open in the Sequence Setup view, go to the next topic, 
“Acquiring Raw Data Files in Sequence Setup.” 

Acquiring Raw Data Files in Sequence Setup
To run your sequence and acquire data

1. Prepare your samples as described in Appendix B, “Sample Preparation.” 

2. Ensure that the sample plate is loaded and the MALDI source has pumped down to the 
operating vacuum level. 

For information on loading a sample plate into the MALDI sample module, see “Loading 
a Sample Plate into the MALDI Sample Module” on page 52.

3. In the Sequence Setup view, do one of the following: 

• Choose Actions > Run Sequence.

• Or, in the view toolbar, click .

4. If the instruments in use has changed, the Change Instruments In Use dialog box appears 
on top of the Run Sequence dialog box. 

By default the MALDI Source is listed as the start instrument. See Figure 77.
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Figure 77. Change Instruments In Use dialog box.

5. Click OK to save the settings and close the Change Instruments In Use dialog box. 

6. In the Run Sequence dialog box, with the exception of the settings listed in the following 
table, use the default settings. Figure 78 shows typical settings for the Run Sequence 
dialog box. 

Parameter Setting Result

Acquisition Options

Start When Ready Xcalibur adds the sequence 
to the end of the 
acquisition queue when 
you click OK. 

After Sequence Set System

Set System Standby The mass spectrometer 
returns to Standby mode 
when the sequence finishes. 

User user name Specifies the name of the 
operator.

Run Rows range of rows to run Specifies the sequence rows 
to run.

Priority Sequence Xcalibur places the 
sequence at the end of the 
acquisition queue. 

MALDI Source 
selected as the 
start instrument
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Figure 78. Run Sequence dialog box with settings for acquiring MALDI data

7. Click OK.

If there are no other runs in the acquisition queue, data acquisition for this sequence 
begins. For tips about running acquisition sequences to collect tissue imaging sequences, 
see Chapter 8, “Tissue Imaging.” 

8. Check the acquisition queue. If the Information view is not visible, click  (Info 
View button) and then click the Acquisition Queue tab.

You can analyze the MS/MS data you acquire using the procedures in this chapter using 
BioWorks. See Chapter 9, “Identifying Proteins Using BioWorks.” 

Click OK to start the sequence run.

Number of rows 
submitted to the 
acquisition queue

Start Instrument
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8

Tissue Imaging

This chapter describes how to prepare tissue samples for imaging with the MALDI LTQ XL 
system and how to take optical and mass spectral scans of the tissue samples.

Using MALDI mass spectrometry, you can use the tissue imaging feature to acquire mass 
spectral data on the spatial distribution of small molecules or peptides in a tissue sample. After 
data acquisition, using ImageQuest, you can visualize and process the data. You must get a 
license to enable the tissue imaging feature.

Contents

• Getting a License for the Tissue Imaging Feature

• Preparing Tissue Slides

• Loading the Tissue Slides onto the Adapter Plate

• Acquiring a Bitmap Image with an External Scanner

• Testing the MALDI Matrix

• Applying the MALDI Matrix to the Tissue Samples

• Importing a Bitmap Image into the Tissue Imaging Page

• Creating a MALDI Position File Using an Imported Bitmap Image

• Creating a MALDI Position File Using the MALDI Camera

• Acquiring Mass Spectral Data from Tissue Samples Using Tune Plus

• Acquiring Mass Spectral Data from Tissue Slides Using Xcalibur
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Getting a License for the Tissue Imaging Feature
To get a license for the MALDI tissue imaging feature

1. Install the LTQ XL instrument control program according to the instructions on the CD 
cover.

2. Get a new license code from Thermo Fisher Scientific. See the next topic “Getting a New 
License Code.” 

3. Install the new license code as described in “Installing a New License Code” on page 124.

Getting a New License Code

To get a license code, use e-mail. 

To get a license code

1. From the desktop of the data system computer, choose Start > All Programs > Xcalibur 
> Instrument Configuration. 

The Xcalibur Instrument Configuration dialog box appears.

2. In the Configured Devices list, double-click the LTQ XL MS button.

The LTQ XL Configuration dialog box appears (see Figure 79).

3. Select License in the list on the left side of the dialog box.

If you do not have a license for the tissue imaging feature, the following message appears:

You are licensed for all standard LTQ features. 
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Figure 79. LTQ XL Configuration dialog box with License selected

4. Click Change license. 

The LTQ License dialog box appears. See Figure 80.

Figure 80. LTQ License dialog box

5. Click Reset.

A dialog box with the following prompt appears:

If you reset the license, your existing license information will be invalidated and you 
will need to obtain a new license for this product. Do you wish to continue?

6. Click Yes to reset the license key.
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A new license key appears in the License box.

7. Highlight the license key in the License box.

8. Press CTRL+C to copy the license key to the Windows clipboard. 

9. Send an e-mail message to licenses.ms@thermo.com: 

a. In the subject line, type License Request. 

b. In the body of the e-mail message, press CTRL + V to paste the license key, and then 
type the following:

• Your name

• Your company name

• Your company address 

• Your company phone number with your extension 

• The serial number that appears below the bar code on the back of the LTQ 2.5 
software CD case 

When Thermo Fisher Scientific Customer Support sends you a new license code, install it as 
described in the next topic.

Installing a New License Code

After you receive your new license code from Thermo Fisher Scientific Customer Support, 
install it as described in the following procedure. 

To install the license code

1. From the desktop of the data system computer, choose Start > All Programs > Xcalibur 
> Instrument Configuration. 

The Xcalibur Instrument Configuration dialog box appears.

2. In the Configured Devices list, double-click the LTQ XL MS button.

The LTQ XL Configuration dialog box appears.

3. Select License in the list on the left side of the dialog box.

4. Click Change license. 

The LTQ License dialog box appears.
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5. In the License box, type the new license number, or copy the license number from the 
e-mail sent from Thermo Fisher Scientific and paste it in the box. 

To avoid copying extra spaces, you can copy the license number from the e-mail and 
paste it into Notepad or Wordpad. Then carefully select the number, and copy it from 
Notepad or Wordpad and paste it in the License box.

6. Once you have pasted the correct number in the License box (without any extra spaces), 
click Set. 

7. Click OK to accept the change in license. 

8. Click OK to close the LTQ License MALDI dialog box. 

9. Click Done to close the Instrument Configuration dialog box.

A dialog box appears with the following message:

The new license number has been set.

10. Click OK.

A dialog box appears with the following prompt: 

In order for the configuration change to take effect, you will need to reboot the data 
system and then the LTQ.

11. Click OK.

12. Reboot the data system computer.

13. Reboot the MALDI LTQ XL system:

a. Press the Reset button on the power entry panel.

b. Take the LTQ XL mass spectrometer out of Standby mode.

c. Take the MALDI source out of Standby mode.

d. Place the MALDI source back in Standby mode.

For more information on rebooting the MALDI LTQ XL system, see “Rebooting the 
MALDI LTQ XL System” on page 38.

Tip  Take care not to copy and paste any extra spaces. Pasting a space in the License 
box causes the license number to be declined.

IMPORTANT  Do not click Reset after you install the new license code. Reset 
invalidates your license.
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Preparing Tissue Slides
For best results, section and prepare the sample just prior to MS analysis.

To prepare the tissue sample and apply it to a slide

1. Flash freeze the sample in liquid nitrogen or isopentane, and then store the sample 
at -80 °C until you are ready to section the tissue.

2. Slice the sample and place it on a slide.

The most commonly used thickness for a tissue sample is 10 to 12 μm. Sections thinner 
than 10 μm are too close to cell size and might not provide optimal results.

You can use either conductive or non-conductive slides with the MALDI LTQ XL 
system. Because linear ion traps do not use high ion extraction potentials, they are not as 
susceptible to inhomogeneities in the field that would affect the ion packet, as opposed to 
axial MALDI-TOF instruments.

3. Prior to applying the MALDI matrix, place the slide with the sample in a desiccator for 
about 30 minutes.

4. Fix or wash the sample to remove compounds such as salts and lipids that can interfere 
with the results, as necessary. 

5. (Optional) Outline the sample areas on the back of the slide with a marker. Once you 
coat the tissue with the matrix, distinguishing the tissue and the matrix becomes difficult.

IMPORTANT  Before you spray the matrix on the tissue sections (“Acquiring a Bitmap 
Image with an External Scanner” on page 129), acquire an optical image of the tissue 
slides. The matrix spray coats the tissue with a layer of white crystals. These crystals 
looks like a white cloud on top of the tissue and make it very difficult to see the tissue 
below, especially once the sample plate is inside the MALDI sample module. 

Note  Take care not to remove the analyte of interest when rinsing tissue sections with 
solvents. When possible, select an appropriate wash solvent based on the relative 
solubilities of the analyte and contaminant. 

CAUTION  Only use a marker pen to place an identifying label on your plates. Do not 
tape anything to the sample plates, as doing so can cause the sample plate to jam 
inside the MALDI sample module.
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Loading the Tissue Slides onto the Adapter Plate
Two adapter plates are provided with the MALDI tissue imaging kit: one for holding glass 
slides and one for holding stainless steel slides. The adapter plate for stainless steel slides 
incorporates magnets to secure the slides. The adapter plate for glass slides holds two slides 
secured with two retaining clips each. 

The adapter plates for tissue imaging use the same base plate as the 96- and 384-well plates. 
You must connect the plate to the base plate before loading it into the MALDI sample 
module. For instruction on connecting the top plate (adapter or well plate) to the base plate, 
see “Assembling the Sample Plate” on page 51. 

When you load the plate assembly into the MALDI sample compartment (see “Loading a 
Sample Plate into the MALDI Sample Module” on page 52), the MALDI imaging system 
recognizes the plate you have inserted as a tissue plate by the marks on the adapter plate.

Figure 81 shows the two adapter plates for slides and the base plate.

Figure 81. Adapter plates for glass slides and stainless steel slides

Adapter plate 
for stainless steel 
slides

Adapter plate 
for glass slides

Base plate

CAUTION  Fit the top plate snugly to the base plate. Loading a misaligned plate assembly 
into the MALDI sample module can damage the MALDI source.
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To secure the glass slides to the adapter plate

1. Turn the adapter plate over so that the retaining clips are visible. See Figure 82.

Figure 82. Back side of the adapter plate for glass slides

2. Pull the retaining clips away from the slide slots.

3. With the tissue samples facing the front of the adapter plate, place the glass slides in the 
slide slots.

4. Push the retaining clips toward the slide slots to retain the slides.

CAUTION  Do not tape anything to the sample plate. Once the plate is loaded into the 
upper chamber of the XYZ mechanism, there is very little space between the plate and the 
ion transfer optics. Loading sample plates with taped objects into the MALDI sample 
module can damage the MALDI source.

Retaining clips

Retaining 
clips
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Acquiring a Bitmap Image with an External Scanner
The MALDI tissue imaging kit includes an HP optical scanner. After you create a bitmap 
image of your tissue slides with the scanner, you can import the images onto the Tissue 
Imaging page of the MALDI Source dialog box in Tune Plus.

To create a bitmap image of your tissue slides with the optical scanner

1. Load your slides onto the adapter plate.

2. Place the scanner frame on top of the scanner glass. See Figure 83.

Figure 83. HP scanner with scanner frame on top of the scanner glass

3. Place the adapter plate into the scanner frame. The tissue slides must be facing the 
scanner glass.

4. From the computer desktop, click the HP Solution Center icon.

The Solution Center window appears. See Figure 84.

Tip  Before applying the matrix, use a marker on the back side of the glass microscope slide 
to outline the tissue. The marker always shows through (whether you scan the image with 
the HP scanner or the MALDI camera), even after coating the tissue with matrix. 

Scanner frame
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Figure 84. HP Solution Center

5. Click Scan Picture.

The Scanning from the Scan Picture button dialog box appears (see Figure 85).
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Figure 85. Scanning from the Scan Picture button dialog box

6. Make the following selections:

• Under What are you scanning?, select the Picture option and the Scan originals 
from glass option.

• Under Where do you want to send the scanned images?, select Bitmap Image 
(*.bmp) in the File Type list.

On the Tissue Imaging page of the MALDI Source dialog box in Tune Plus, you can 
only open image files saved as bitmap images.

• Select the Show Preview check box.

7. Click HP Photosmart Premier Save Options.

The HP Photosmart Premier Save Options for the Scan Picture button dialog box 
appears. See Figure 86.
hermo Scientific MALDI Source Getting Started Guide 131



8 Tissue Imaging
Acquiring a Bitmap Image with an External Scanner

132
Figure 86. HP Photosmart Premier Save Options for the Scan Picture button dialog box

8. Make the following selections and entries:

• Under File Type, select Bitmap Image (*.bmp).

• Under Base File Name, type an appropriate name to identify the file.

• Under Save Location, browse to or type the location where you want to store the 
bitmap image files. 

9. Click OK to accept the settings and return to the Scanning from the Scan Picture button 
dialog box. See Figure 85.

10. Click Scan Picture Settings.

The Scan Picture Settings for the Scan picture button dialog box appears. See Figure 87.
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Figure 87. Scan Picture Settings for the Scan Picture button 

11. Make the following selections:

• In the Resolution (ppi) list, select 600.

• In the Output Type list, select Millions of Colors.

• Under When scanning picture from the glass, select the scan single picture to file 
option.

12. Click OK to accept the settings and return to the Scanning from the Scan Picture button 
dialog box.

13. Click Scan.

The scanning process begins. The image is stored to the specifed file location as a bitmap 
image (*.bmp).
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Testing the MALDI Matrix
For best results, before coating the entire tissue, test the MALDI matrix you plan to use by 
analyzing a test spot on a tissue sample. For information on selecting an appropriate MALDI 
matrix, see Appendix B, “Sample Preparation.” 

To test the MALDI matrix

1. Prepare the tissue slide (see “Preparing Tissue Slides” on page 126).

2. Use a spotter to spot the tissue with one or more MALDI matrix compounds. Mark the 
spotted areas and label the spots if you are testing more than one type of MALDI matrix.

3. Load the tissue slide onto the adapter plate (see “Loading the Tissue Slides onto the 
Adapter Plate” on page 127).

4. Connect the adapter plate to the base plate (see“Assembling the Sample Plate” on 
page 51).

5. Load the sample plate into the MALDI sample module (see “Loading a Sample Plate into 
the MALDI Sample Module” on page 52).

6. As you view the mass spectrum produced by the test spot (see “Interactively Acquiring 
Data for Tissue Samples in Tune Plus” on page 145), manually optimize the tune 
parameters. After you determine the optimum tune parameters (see Table 4 on page 60) 
for your sample, save the tune parameters in a tune file. 

7. Eject the sample plate from the MALDI sample module and prepare the tissue sample for 
analysis.

Applying the MALDI Matrix to the Tissue Samples
However you choose to apply the MALDI matrix, the key to matrix application for 
determining compound distribution in a tissue is to apply the matrix as uniformly as possible, 
forming the smallest crystals possible when the matrix co-crystallizes with the analyte. You can 
apply the matrix with one of the following tools:

• Airbrush

• Commercial nebulizer

• Spotters

Several commercial airbrushes suitable for applying the matrix are available from 
manufacturers such as Aldrich (thin layer chromatography), Testors (Aztek airbrush), and 
Meinhard (nebulizers).

IMPORTANT  Before applying the matrix, use the HP scanner to scan a bitmap image of 
your tissue 
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To apply the matrix with an airbrush

1. Connect the airbrush to a high-quality, compressed nitrogen tank with a regulator for 
controlled air flow.

2. Set the airbrush on a stand.

3. Clamp on the air flow regulation lever.

4. Select the drop size.

5. Fill the liquid reservoir with the solvent used as a diluent for the matrix and test the 
drop size. 

6. Adjust the drop size if necessary to obtain the correct uniformity.

7. Fill the liquid reservoir with the matrix solution and test the drop size again.

8. Apply the matrix. 

The matrix should be a fine mist that covers the tissue and is not too dry or too wet.

Importing a Bitmap Image into the Tissue Imaging Page
You can import the bitmap image acquired by scanning the tissues slides with the HP scanner 
into the Tissue Imaging page.

To import a bitmap image (600 ppi) created with the external scanner

1. Open Tune Plus by doing one of the following:

• From the Windows™ Start menu, choose All Programs > Xcalibur > LTQ Tune.

• From the computer desktop, double-click the LTQ Tune shortcut icon.

2. In Tune Plus, choose Setup > MALDI Source.

3. Click the Tissue Imaging tab

The Tissue Imaging page opens.

4. Select the Use Tissue Imaging Feature check box.

5. In the Optical Image Scan area, select the Importing option. See Figure 88.

Tip  Before applying the matrix, use a marker on the back side of the glass microscope slide 
to outline the tissue. The marker always shows through (whether you scan the image with 
the HP scanner or the MALDI camera), even after coating the tissue with matrix. 
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Figure 88. View of the Importing option in the Tissue Imaging page

6. Click Import Image.

The Open dialog box appears. 

7. Browse to the folder where you saved the scanned bitmap image, select the bitmap image 
of interest, and click Open.
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The image created with the HP scanner appears in the Image Position box at the bottom 
of the MALDI Source dialog box (see Figure 89).

Figure 89. View of an imported bitmap image in the Image Position box
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Creating a MALDI Position File Using an Imported Bitmap Image
MALDI position files (*.MALDIpos) contain the bitmap image of the tissue and the MS 
scanning selections. If you do not make any MS scanning selections, the MALDI program 
uses the settings listed in Table 9.

With the above settings (assuming a rectangular tissue shape), the MALDI X-Y stage moves 
the sample plate in the pattern shown below. The circles represent the areas that the laser fires 
on. The distance between each circle is the step size.

MALDI position files for tissue imaging plates are analogous to well plate locations of well 
plates. To acquire data with a sequence file, create MALDI position files of the areas interest. 

To create a MALDI position file of a selected tissue area from an imported image

1. Import the bitmap image as described in “Importing a Bitmap Image into the Tissue 
Imaging Page” on page 135.

2. Select the tissue area where you want to acquire MS scan data, by doing one of the 
following:

• Crop and select the tissue area from a magnified view of the plate as described in 
step 3 and step 4.

• (Optional for large tissues) In the Image position box at the bottom of the MALDI 
Source dialog box, hold down the SHIFT key and drag the cursor to select the tissue 
area of interest. The selected rectangular area appears in the Image Position area at 
the bottom of the MALDI Source dialog box. 

3. Crop the tissue area from a magnified view of the plate:

a. Click View Plate.

The Tissue Image window opened by clicking the View Plate button appears (see 
Figure 90).

Table 9. Default MALDI position file settings

Parameter Default setting

Tissue Shape Shape of the selected tissue area

Plate Motion Raster

Raster Step Size (μm) 100 

100 μm
raster step size
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Figure 90. Tissue Image window opened by clicking the View Plate button

b. Ensure that the Fixed raster step size while selecting a MS scan area button is 
depressed (see Figure 90).

c. Click the  Crop current image to a selected rectangle button.

d. Hold down the left mouse button and drag the curser to crop the tissue area of 
interest. 

The cropped area appears in the Tissue Image window and all the toolbar buttons 
become available (see Figure 91).

Depressed 
fixed raster step size 

button
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Figure 91. Tissue Image window with cropped tissue area
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4. In the cropped tissue image, further refine the tissue area to be scanned:

a. Click the appropriate toolbar button. 

b. To select a rectangular, elliptical, or free form area selection, hold down the left 
mouse key and drag the cursor. To select individual points click the points of interest 
in the image.

5. To save a bitmap image of the selected tissue, click  in the Tissue Image window. The 
Save As dialog box appears. Type a file name in the File name box and click Save. The 
MALDI program automatically saves the file as a bitmap image (*.bmp).

6. Click  to close the Tissue Image window.

The cropped area is outlined in the Image Position box at the bottom of the MALDI 
Source dialog box. An outline of the selected tissue area appears to the right of the Image 
Position box. Figure 92 shows a tissue area selected with the Free Form area tool.

Under MS image scan, the Tissue Shape list displays the shape of the selected tissue. The 
Plate Motion list displays the Raster selection, and the Raster Step Size box display a value 
of 100 μm. 

Toolbar button Selection Toolbar button Selection

Rectangle Free form area

Ellipse Individual points

Note  Clicking  in the Tissue Image window saves the image as a bitmap file, not 
as a MALDI position file.
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Figure 92. Tissue Imaging page with a view of the cropped tissue area

Cropped area

Free form tissue area

Save As MALDI position file button
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7. In the MS Image Scan area of the Tissue Imaging page, for most applications, use the 
plate motion and raster step size automatically selected by the MALDI program (see 
Table 9 on page 138). 

An estimate appears of the time required to complete the scan, assuming a scan rate of 
1 scan/second.

8. Click  in the Tissue Imaging dialog box.

The Save Tissue Position File As dialog box appears.

9. Type a name in the File name box.

10. Click Save to save the file and close the dialog box.

By default, the program stores MALDI position files (*.MALDIpos) in the following 
folder:

drive:\Xcalibur\methods

Creating a MALDI Position File Using the MALDI Camera
You can create a MALDI position file by scanning the sample plates with the MALDI camera. 

To create a MALDI position file by scanning the image with the MALDI camera

1. Open Tune Plus by doing one of the following:

• From the Windows Start menu, choose All Programs > Xcalibur > LTQ Tune.

• Or, from the computer desktop, double-click the LTQ Tune shortcut icon.

2. In Tune Plus, choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control tab shown by default.

3. Load the sample plate with the tissue slides into the MALDI sample module as described 
in “Loading a Sample Plate into the MALDI Sample Module” on page 52.

4. Click the Tissue Imaging tab.

The Tissue Imaging page opens (see Figure 88 on page 136).

5. Select the Use Tissue Imaging Feature check box.

6. In the Optical Image Scan area, select the Scanning option.

The image scanning features become available.
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7. In the Image Quality list, select an appropriate resolution value (see Table 10). Increasing 
the image quality increases both the file size of the image and the time required to scan it.

8. In the Image Area list, select the area of the plate to be scanned.

The available selections (see Table 11) depend on the plate type in the MALDI sample 
module.

9. If you selected Selected Area for the image area, hold down the SHIFT key and drag the 
cursor in the Plate Image portion of the MALDI Source dialog box to select the tissue 
area of interest.

The selected area is outlined in the Plate Image portion of the dialog box. An estimate 
appears of the time required to complete the optical scan.

10. Click Scan Image.

The program scans the image. When the scan ends, the Tissue Image window appears. 

11. Select the tissue area of interest. (The area for which you want to collect MS scan data.)

12. Click  to close the Tissue Image window.

The MALDI Source dialog box appears open to the Tissue Imaging page.

13. In the MS Image Scan area of the Tissue Imaging page, select the scanning options. 

An estimate appears of the time required to complete the scan assuming a scan rate of 
1 scan/second.

14. Save the image as a MALDI position file (*MALDIpos):

a. Click  in the Tissue Imaging dialog box.

The Save Tissue Position File As dialog box appears.

Table 10. Image quality selections

Image Quality Description

Survey A very fast, low-resolution scan that reveals the position of the tissue 
sample on the plate

Coarse A fast scan that is appropriate if the image quality is not important

Normal A typical scan that is good for most applications

Fine A high-resolution scan that yields the best possible image

Table 11. Image Area selections

Plate type Selections

Stainless steel slides selected area, slide 1, slide 2, slide 3, and slide 4

Glass slides selected area, slide 1, and slide 2

Well plate selected area and whole plate
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b. Type a name in the File name box and click Save.

The program automatically saves the file as a MALDI position file. By default, the 
program stores MALDI position files (*.MALDIpos) in the following folder:

drive:\Xcalibur\methods

Acquiring Mass Spectral Data from Tissue Samples Using Tune Plus
You can acquire a data file in Tune Plus by interactively defining the scan parameters for the 
LTQ XL mass spectrometer and setting the MALDI source parameters or you can acquire a 
data file by using an instrument method.

This topic contains these procedures:

• Interactively Acquiring Data for Tissue Samples in Tune Plus

• Using an Instrument Method to Acquire Data for Tissue Samples in Tune Plus

Interactively Acquiring Data for Tissue Samples in Tune Plus

To interactively acquire mass spectral data from tissue samples in Tune Plus

1. Prepare the tissue slides (see “Preparing Tissue Slides” on page 126) and load them onto 
the adapter plate (see “Loading the Tissue Slides onto the Adapter Plate” on page 127). 

2. Use the HP scanner to scan the sample plate and acquire a bitmap image.

See “Acquiring a Bitmap Image with an External Scanner” on page 129.

3. Apply the MALDI matrix to the tissue slides.

See “Applying the MALDI Matrix to the Tissue Samples” on page 134.

4. Load the sample plate into the MALDI sample module.

See “Loading a Sample Plate into the MALDI Sample Module” on page 52.

5. Start Tune Plus:

• From the computer desktop, choose Start > All Programs > Xcalibur > LTQ Tune.

• Or, double-click the  LTQ Tune shortcut icon on the computer desktop.

6. In the Tune Plus window, do the following:

a. Choose File > Open and select the tune file for your analyte of interest. 

For best results, prepare a test sample spot and determine the optimal tune 
parameters (see Table 4 on page 60) for your sample as described in “Testing the 
MALDI Matrix” on page 134.

b. Set up the scan parameters for the LTQ XL mass spectrometer.
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See “Acquiring Sample Data Interactively in Tune Plus” on page 87. 

c. Choose Setup > MALDI Source.

The MALDI Source dialog box appears with the Control page shown by default.

7. Click the Tissue Imaging tab.

8. On the Tissue Imaging page, do the following:

a. Select the Use Tissue Imaging Feature check box.

b. Click  to the right of the Tissue Position File box. The Open Tissue Position 
File dialog box appears. Select the MALDI position file for the sample plate you are 
analyzing, and then click Open.

The image stored in the MALDI position file appears in the image view at the 
bottom of the MALDI Source dialog box.

c. Select the tissue area that you want to scan. If you make changes that affect the 
MALDI position file, save the changes to a new MALDI position file.

d. Click Apply.

9. In the MALDI Source dialog box, click the Acquire tab.

The Acquire page appears. See Figure 93.

Figure 93. Top portion of the Acquire page

10. Specify the file location and file name:

• Select the file folder by clicking  and browsing to the appropriate directory.

• Specify the file name by typing a name in the File Name box.

Three separate boxes separated by underscores constitute the file name: the base file 
name box, the sample position box, and the suffix box. The program automatically 
fills in the sample position box with TI (for tissue imaging) and the suffix box with a 
date stamp.

IMPORTANT  The setting for Microscans in the Define Scan dialog box must 
match the setting for the Microscans per Step in the MALDI Source dialog box - 
Control page.
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• (Optional) In the Sample Name box, type the sample name. 

• (Optional) In the Comment box, type additional comments about the sample or 
experiment. 

11. In the MALDI Source dialog box, click the Control tab.

12. On the Control page, do the following:

a. Under MALDI Settings, make sure ASF is Off.

b. Under Acquisition settings, type a name for the data file to be acquired.

c. Click Apply.

d. To start data acquisition, click .

The laser starts firing. The system starts scanning and acquiring data to an Xcalibur 
raw data file.

e. To stop data acquisition before the end of the sample, click .

The MALDI source goes into Standby mode.

Using an Instrument Method to Acquire Data for Tissue Samples in Tune Plus

To acquire a data file using a stored instrument method

1. Prepare the sample plate and load it into the MALDI sample module.

2. Start Tune Plus.

3. Choose Setup > MALDI Source.

The MALDI Source dialog box appears with the Control page shown by default.

4. Click the Tissue Imaging tab.

The Tissue Imaging page appears.

5. Select the Use Tissue Imaging Feature check box.

6. Open a Tissue Position File:

a. Click  to the right of the Tissue Position File box. 

The Open Tissue Position File dialog box appears. 

b. Select the MALDI position file for the sample plate you are analyzing, and then click 
Open.

The image stored in the MALDI position file appears in the image view at the 
bottom of the MALDI Source dialog box.

7. Click the Acquire tab.

The Acquire page appears.
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8. Make the appropriate entries and selections for the data file location and name. See 
step 10 on page 146.

9. Select the Use Instrument Method check box, and then select a tissue imaging method 
(see Figure 94).

For information on creating an instrument method, see “Creating an Instrument Method 
for Tissue Imaging” on page 150.

Figure 94. Top portion of the Acquire page

10. In the Tissue view at the bottom of the page, select the area of interest.

11. Click Apply.

12. To start data acquisition, click .

The laser starts firing. The system starts scanning and acquiring data (as specified in the 
instrument method) to an Xcalibur raw data file. When the system completes the 
method, the MALDI source returns to Standby mode.
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Acquiring Mass Spectral Data from Tissue Slides Using Xcalibur
You can automate the collection of mass spectral data for a tissue sample by creating a 
MALDI position file, a tissue imaging instrument method, and an acquisition sequence. You 
use Tune Plus to create MALDI position files and tune files. You use the Xcalibur data system 
to create instrument methods and acquisition sequences.

The MALDI position file contains a bitmap image of the tissue slides and the MS scanning 
parameters, including the plate motion. The instrument method contains the tune file created 
for the analytes of interest (see “Tuning on an Analyte” on page 60) and the experiments to be 
performed by the LTQ XL mass spectrometer. Each row of the acquisition sequence contains 
information to acquire a data file, including the data file name, the instrument method, and 
the MALDI position file.

To automatically acquire a set of (*.raw) data files in Xcalibur

1. Create a tune file for your analytes (see “Tuning on an Analyte” on page 60).

2. Prepare the tissue slides (see “Preparing Tissue Slides” on page 126) and load them onto 
the adapter plate (see “Loading the Tissue Slides onto the Adapter Plate” on page 127). 

Because a tissue imaging instrument method must be accompanied with a MALDI 
position file, perform step 3, step 8, or both to create a MALDI position file.

3. Take a (600 ppi) scan of the tissue slides (see “Acquiring a Bitmap Image with an External 
Scanner” on page 129). Import this image into the Tissue Imaging page of the MALDI 
Source dialog box and create a MALDI position file.

4. (Optional) Test the matrix and optimize the laser energy, number of microscans and 
microscans per step (see “Testing the MALDI Matrix” on page 134)

5. Apply the MALDI matrix to your tissue sample (see “Applying the MALDI Matrix to the 
Tissue Samples” on page 134).

6. Take a second optical scan of the sample plate with the matrix applied.

7. Load the sample plate into the MALDI sample compartment (see “Loading a Sample 
Plate into the MALDI Sample Module” on page 52).

8. (Optional) Take a scan of the target area with the MALDI camera and create a MALDI 
position file.

Taking a scan of the entire tissue using the MALDI camera can be quite time consuming. 
To reduce the amount of time required to produce an image of the desired target area, 
acquire a bitmap image (600 ppi) of the entire tissue using the external scanner. Import 
this image onto the Tissue Imaging page, and then select a portion of the plate to be 
scanned with the MALDI camera.

9. (Optional) Acquire a test data file. See “Interactively Acquiring Data 
for Tissue Samples in Tune Plus,” on page 145.

10. Create an instrument method for tissue imaging. See the next topic. 
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11. Create an acquisition sequence (see “Creating an Acquisition Sequence for Tissue 
Imaging” on page 151).

12. Run the sequence (see “Acquiring Raw Data Files in Sequence Setup” on page 117).

Creating an Instrument Method for Tissue Imaging

“Creating an Instrument Method” on page 105 provides more information on creating 
instrument methods. The following procedure describes the settings required to create a tissue 
imaging instrument method.

To create a tissue imaging instrument method

1. In the Xcalibur Instrument Setup window, select the template for the type of experiment 
you want to perform. See Figure 95.

Figure 95. General MS or MSn template with Tissue Imaging selected in the Plate motion list

2. In the instrument method template, select Tissue Imaging in the Plate motion list. 

When you select Tissue Imaging, ASF is unavailable.

3. In the Microscans per step box, type or select the number of microscans per step. 

A step is a change in the plate position. The position of the laser is static. The MALDI 
X-Y stage moves the tissue plate as specified by the plate motion settings in the MALDI 
position file.

When you create a tissue imaging instrument method, you can overwrite the microscans 
setting in the tune file. When you increase the number of microscans per step, you also 
increase the acquisition time.

IMPORTANT  The number of microscans (in the Tune file) must match the number 
of microscans per step (in the instrument method).
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4. Set up the scan events.

5. Save the instrument method. Use a name that you can identify as a tissue imaging 
instrument method.

Creating an Acquisition Sequence for Tissue Imaging

You must specify a position file for each row in the sequence that contains a tissue imaging 
instrument method. You can use the same position file or different position files for every row 
of the sequence.

These procedures describe how to specify the position file in an Xcalibur sequence list:

• Specifying the Same Position File for the Entire Sequence

• Specifying a Different Position File for Each Sequence Row

Specifying the Same Position File for the Entire Sequence

To specify the same position file for the entire sequence

1. Open the Tissue Imaging page:

a. In Tune Plus, choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default.

b. Click the Tissue Imaging tab.

The Tissue Imaging page opens.

c. Select the Use Tissue Imaging Feature check box.

2. Click to the right of the Tissue Position File box, and open the MALDI position file of 
interest. See Figure 96.

Figure 96. Highlighted tissue position file

3. Highlight the entire path and file name of the file including the .MALDIpos file 
extension.

4. Press CRTL + C to copy the name of the MALDI position file, including its file 
extension, to the clipboard.

5. Open the New Sequence Template dialog box:

a. Open Xcalibur by choosing Start > All Programs > Xcalibur > Xcalibur. 
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b. In the Xcalibur Home Page - Roadmap view, click the Sequence Setup  
button.

The Sequence Setup Home Page window appears. 

c. Choose File > New. 

The New Sequence Template dialog box appears. 

6. Under Samples, highlight A1 in the Initial Vial Position box. See Figure 97.

The default vial position for the New Sequence Template is A1.

Figure 97. Highlighting the text in the Initial Vial Position box

7. Press CRTL + V to paste the name of the MALDI position file from the clipboard into 
the Initial Vial Position box. See Figure 98.

Figure 98. Pasting the name of the MALDI position file in the Initial Vial Position box

Default vial position

View of the last few characters in the filename of 
the MALDI position file
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8. Under Samples, in the Injections per Sample box, type a number to specify the number of 
data files you want to acquire (see Figure 98).

9. Under General (see Figure 98), make the following entries and selections:

• In the Base File Name box, type a file name. Xcalibur does not accept spaces within 
base file names.

• In the Path box, type or browse to an appropriate directory.

• In the Instrument Method box, browse to the folder where you store your instrument 
methods, and select a tissue imaging method.

10. In the New Sequence Template dialog box, use the default settings in the remaining areas 
of the template.

11. Click OK to accept the settings and exit the New Sequence Template dialog box.

The sequence list appears in the Sequence Setup view. See Figure 99.

Figure 99. Sequence file with tissue imaging method and position file

12. Save the sequence file.

tissue imaging method MALDI position file
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Specifying a Different Position File for Each Sequence Row

To specify a different position file for each row of the sequence

1. Create an acquisition sequence as described in “Creating an Acquisition Sequence” on 
page 113.

2. Follow step 1 to step 4 on page 151 to copy the name of the position file from the Tissue 
Position File of the MALDI Source dialog box to the clipboard.

3. In the sequence row of interest, place the cursor in the Position box.

4. Press F2 twice. 

The Cell Text dialog box appears. 

5. Paste the text into the Cell Text box. 

Figure 100 shows the text string pasted in the Cell Text box.

Figure 100. Cell Text dialog box
\

6. Click OK. 

The text string appears in the Position cell of the sequence list.

Checking the Acquisition Sequence

For the MALDI LTQ XL system, sequence rows contain standard runs or tissue imaging 
runs: 

• A tissue imaging run includes a tissue imaging instrument method and a MALDI 
position file. A tissue imaging method is an instrument method that has Tissue Imaging 
selected for the plate motion. Figure 101 shows the MALDI settings area of the 
Instrument Setup view with Tissue Imaging selected as the Plate motion.

• A standard run includes a non-tissue imaging instrument method and a well plate 
location. 
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Figure 101. MALDI settings in the Instrument Setup view 

When you select a tissue imaging method for a sequence row, you must specify a MALDI 
position file in the Position column for that row. See Figure 99 on page 153.

When you submit a sequence to the acquisition queue, Xcalibur does not check the sequence 
to verify that each row contains a valid instrument method and position type. When a 
sequence row reaches the front of the queue, the acquisition server sends out a Prepare for 
Run command. If the sequence row contains a mismatched instrument method and position 
type, the sequence pauses and the program generates an error message. Figure 102 shows the 
error message that the program generates when you do not match the instrument method to 
the position type.

Figure 102. Acquisition Server error message

To obtain more information about errors, open the LTQ XL Instrument Console using the 
following procedure.
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To open the LTQ XL Instrument Console

1. Double-click the LTQ XL Instrument Console icon on the right side of the task bar.

The LTQ XL Instrument Console opens. 

Figure 103 shows the error message that the system generates when it attempts to initiate 
a run for a sequence row containing a tissue imaging instrument method and a well 
position. 

Figure 103. LTQ XL Instrument Console

Error message
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Identifying Proteins Using BioWorks

This chapter briefly describes how to use the BioWorks™ 3.3.1 program to analyze your 
MALDI MS/MS data. It also highlights the search parameters that are specific for ions 
generated by the MALDI source.

After you have completed the automated analysis of your protein digest samples, you can use 
BioWorks to search protein, nucleotide, and genomic databases from your RAW file. Use 
BioWorks to cross-correlate MS/MS mass spectra from peptides with the theoretical mass 
spectra produced from sequences generated from either a protein or translated nucleotide 
FASTA database.

For more information about BioWorks, see the BioWorks User Guide and Help.

Using BioWorks to Identify Proteins
To analyze your MALDI MS/MS data with BioWorks, complete the following procedures:

1. Opening the RAW Data File

2. Defining the Search Parameters

3. Modifying the DTA Generation Parameters

4. Setting SEQUEST Search Parameters

5. Searching and Viewing the Results

Contents

• Using BioWorks to Identify Proteins

• Opening the RAW Data File

• Defining the Search Parameters

• Modifying the DTA Generation Parameters

• Setting SEQUEST Search Parameters

• Searching and Viewing the Results
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Opening the RAW Data File
To start BioWorks and open a MALDI data file

1. From the Windows taskbar, choose Start > All Programs > Xcalibur > BioWorks 
Browser to open the BioWorks Browser window.

2. Choose File > Open Analysis file (.RAW) to display the Open RAW File dialog box. 

3. Select a RAW file to be analyzed.

4. Click Open.

The BioWorks Browser window changes to display the chromatogram of the RAW file 
with the mass spectrum below it. The chromatogram of a MALDI experiment displays 
relative or absolute abundance of the total ion current versus time (min.).

You are now ready to define the search parameters as described in the procedure “Defining 
the Search Parameters” on page 158.

Defining the Search Parameters
BioWorks contains the SEQUEST™ application that enables you to search protein and 
peptide databases. Use SEQUEST to cross-correlate uninterpreted MS/MS mass spectra of 
peptides with single-letter-coded amino acid sequences from protein databases or with 
three-letter-coded nucleotide sequences from nucleotide databases.

To set and save search parameters

1. Choose Actions > SEQUEST Search. The SEQUEST Search dialog box opens with the 
Basic page shown (Figure 104).

Note  The default SRF file name is the name of your RAW file with the .srf extension. 
Thermo Fisher Scientific recommends you create a unique name for your SRF file. 
The default location for your search results is: \Xcalibur\sequest\.
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Figure 104. MALDI settings for SEQUEST Search Basic page

2. In the Location of the Search Results area, type your SRF file name in the File/Folder box. 

3. From the Instrument type list, select vMALDI LTQ.

Automatically the Use charge state, MSn level, and Activation type settings are changed 
to match the vMALDI LTQ instrument type.

4. Modify the DTA Generation settings as defined in the procedure “Modifying the DTA 
Generation Parameters” on page 160.

5. Define and save the search parameters as defined in the procedure “Setting SEQUEST 
Search Parameters” on page 161.

6. In the SEQUEST Search dialog box, click Start Search to begin the search analysis.

• The SEQUEST Search box closes.

• The SEQUEST Progress box opens, showing the progress of the search.

Displays Browse 
dialog box

Displays DTA 
Generation Parameters 
dialog box

Displays SEQUEST 
Search Parameters 
dialog box
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• When the parameters in the SEQUEST Search dialog box are saved and the search is 
started, these parameters are written to the .params file in the Xcalibur results 
directory.

To view and interpret the SEQUEST search results, see “Searching and Viewing the Results” 
on page 164.

Modifying the DTA Generation Parameters
Use the DTA Generation Parameters dialog box to modify the .dta generation parameters. 
The DTA Generation settings described in this procedure are typically used for MALDI data.

To modify the .dta generation parameters

1. On the Basic page of the SEQUEST Search dialog box, click Modify (Figure 104 on 
page 159). The Dta Generation Parameters dialog box appears as shown in Figure 105.

Figure 105. DTA Generation Parameters settings

2. In the Minimum ion count box, type 5.

3. In the MW range box, type 500.00-4000.00.

4. When the Absolute threshold is selected, type 100 in the Threshold box.

5. Select Make these values the default DTA Generation Parameters for this type of 
instrument check box. Your settings are saved so that they can be reused the next time 
you select this instrument type for your search.

6. Click OK to save the settings and close the Dta Generation Parameters dialog box. 

The SEQUEST Search parameters dialog box appears (Figure 104 on page 159).
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7. Continue setting the parameters for SEQUEST Search dialog box. See “Setting 
SEQUEST Search Parameters” on page 161.

Setting SEQUEST Search Parameters
The search parameters described in this procedure are typically used for tryptic digests of 
proteins.

To set SEQUEST Search Parameters

1. On the Basic page of the SEQUEST Search dialog box, in the Search Parameters area, 
click Edit (Figure 104 on page 159). 

The Basic page of the SEQUEST Search Parameters dialog box appears as shown in 
Figure 106.
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Figure 106. MALDI settings for SEQUEST search parameters

2. In the Number results scored box, type 250.

3. From the Enzyme list, select Trypsin (KR) if this enzyme was used to digest your protein.

4. From the Database list, select a FASTA file. This search example uses bovine.

5. In the Missed cleavage sites box, type 2.

6. In the Peptide tolerance box, type 2.000.

7. From the Fragment ions tolerance list, select 1.0.

8. In the Parameters file box, type a file name for this parameters file.

9. Click Modifications to display the page for chemical modifications. See Figure 107.
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Figure 107. MALDI settings for chemical modifications

10. In the Differential/PTM area in the AA column, type an amino acid. Type the one-letter 
abbreviation for the amino acid. See Figure 107.

11. For each amino, click the corresponding cell in the Mass column and type the mass of the 
modification, or right-click the cell and choose a specific modification. The mass of the 
modification or the selected item appears. See Figure 107.

Note  Differential modifications, also known as variable or amino acids modifications, 
are mainly used for determining post translational modifications (PTMs). Some 
phosphorylated peptide serines will be modified and some will not be modified. Static 
modifications apply the same specific mass to all occurrences of that named amino 
acid, as in an exhaustive chemical modification. 
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12. Click Save to save your settings and close the Search Parameters dialog box.

The SEQUEST Search dialog box appears.

13. Continue setting the parameters for SEQUEST from step 6 in the procedure “Defining 
the Search Parameters” on page 158.

Searching and Viewing the Results
When the search is complete, the SEQUEST Progress message box closes. BioWorks Browser 
changes to display the chromatogram (top pane), the search results in a summary table 
(bottom pane), and .dta files in the Info Bar (left pane). See Figure 108. Each pane provides 
unique information you can use to analyze your search results. The panes contain the 
following:

• The Chromatogram window displays a visual depiction of the MALDI experiment with 
total ion current versus the time for the experiment.

• The Results table shows the probability calculations, scores, and other values for the 
matching peptides and proteins from the SEQUEST search. 

• The DTA Information in the Info Bar pane displays the scans, the charge states, and the 
time required to process each .dta file. 
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Figure 108. BioWorks Browser window showing the MALDI data search results

The SEQUEST Results report displays a list of matching peptide and protein sequences with 
various probability calculations indicating how good the match is for your peptide or protein. 
Also, the protein and peptide summaries can be exported to Microsoft™ Excel™ for further 
analysis or archiving. 

Refer to the BioWorks User Guide for additional information on setting filters, accessing other 
views, and interpreting your search results.

Infobar

Results table

Chromatogram

DTA Information

Protein 
row

Access to other views
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ProteoMass Calibration Kit

This appendix describes how to prepare the calibration and sensitivity test spots.

IMPORTANT  Use clean and dry sample plates to prepare the calibration and sensitivity 
test spots. To ensure dryness, store the sample plate under vacuum in the MALDI sample 
module as you prepare the calibration mixes.

Contents

• Calibration Kit Description

• Preparing the Mass Calibration Targets

• Preparing the Sensitivity Test Targets

CAUTION  Store and handle all chemicals in accordance with standard safety procedures. 
The Material Safety Data Sheets (MSDSs) describing the chemicals being used are to be 
freely available to lab personnel for them to examine at any time. Material Safety Data 
Sheets (MSDSs) provide summarized information on the hazard and toxicity of specific 
chemical compounds. MSDSs also provide information on the proper handling of 
compounds, first aid for accidental exposure, and procedures for the remedy of spills or 
leaks. Producers and suppliers of chemical compounds are required by law to provide their 
customers with the most current health and safety information in the form of an MSDS. 
Read the material safety data sheets for each chemical you use.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear protective gloves when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear safety glasses when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 
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Calibration Kit Description
The Sigma ProteoMass™ Calibration Kit (MS CAL4) contains a range of standard peptides 
for the purpose of calibrating and testing the MALDI LTQ XL mass spectrometer. The kit 
provides high-purity, low-alkali metal solvents, and recrystallized matrices, and provides 
standards which are ideal for most applications. 

Storage/Stability 

The kit is shipped at ambient temperature. Store the kit at 2 to 8 °C. Matrices, after 
reconstitution in solvent, are stable for approximately one week at room temperature if 
protected from light. Some methionine oxidation can occur over time in MRFA [a small 
peptide (methionine-arginine-phenylalanine-alanine)], which is one of the peptides in the 
Normal Mass Calibration Mix.

Matrix and Solvents

Recrystallized alpha-cyano-4-hydroxycinnamic acid comes in 2.0 mL amber vials. Solvents 
come in high-density polyethylene bottles. See Table 12 for more details.

ProteoMass Normal Mass Calibration Mix (Product Code C 9241)

The normal mass calibration mix is supplied in clear 0.5-mL vials, containing optimal 
quantities of the standard peptides indicated in Table 13. Each kit contains five vials. 

Table 12. Matrix and solvents

Product code CAS number Product Amount

C 8982 28166-41-8 alpha-cyano-4-hydroxycinnamic acid 5 × 10 mg

T 3693 76-05-1 1% trifluoroacetic acid (TFA) solution 4 mL 

A 8596 75-05-8 Acetonitrile 30 mL 

E 7023 64-17-5 Ethanol, 200 proof, molecular biology grade 10 mL 

Table 13. ProteoMass Normal Mass Calibration Mix for the normal mass range

Peptide CAS number (M+H)+ Monoisotopic mass

MRFA 67368-29-0 524.27

Bradykinin 1-7 23815-87-4 757.40

Bradykinin 5979-11-3 1060.57

Angiotensin I 70937-97-2 1296.69

Neurotensin 58889-67-1 1672.92

Renin Substrate 20845-02-7 1758.93
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ProteoMass High Mass Calibration Mix (Product Code C 9366)

The High Mass Calibration Mix is supplied in clear 0.5-mL vials, containing optimal 
quantities of the standard peptides indicated in Table 14. Each kit contains five vials of the 
High Mass Calibration Mix.

ProteoMass Angiotensin II Sensitivity Standard (A 9854)

The sensitivity standard is supplied in clear 0.5 mL vials. Each vial contains 500 pmol of 
angiotensin II. 

Table 14. ProteoMass High Mass Calibration Mix for the high mass range

Peptide CAS number (M+H)+ Monoisotopic mass

MRFA [67368-29-0] 524.27

Bradykinin [5979-11-3] 1060.57

ACTH 1-16 [5576-42-1] 1936.99

Melittin [20449-79-0] 2845.75

ACTH 7-38 [68563-24-6] 3657.93
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Preparing the Mass Calibration Targets
In addition to the solvents, reagents, and protein mixes included in the ProteoMass 
Calibration kit, you must have extra 1.7-mL centrifuge tubes and pipettes to prepare and spot 
the calibration samples.

To prepare the calibration targets used to calibrate the normal and high mass range of the 
MALDI LTQ XL system, follow these procedures:

1. Preparing the Solvent Mixtures

2. Reconstituting the Calibration Mixes

3. Preparing the Matrix Solution for the Calibration Targets

4. Preparing the Calibrant/Matrix Mixtures

5. Spotting the Calibrant/Matrix Mixtures on the Sample Plate 

Preparing the Solvent Mixtures

Use these solvent mixtures to prepare the calibrant/matrix mixtures:

• 0.1% by volume TFA in water (10-fold dilution of the 1% TFA solution in the kit)

• Solvent 1: a solution of 80% HPLC grade water, 20% acetonitrile (v/v)

• Solvent 2: a solution of 3% (0.1% TFA in water), 13% ethanol, 84% acetonitrile (v/v/v)

To prepare 1 mL of 0.1% TFA in water

Mix 100 μL of 1% TFA (provided in the kit) with 900 μL of HPLC-grade water (or 
18 MΩ-cm deionized water) in a 1.7-mL microcentrifuge tube.

To prepare 1 mL of Solvent 1

Mix 800 μL of HPLC-grade water (or 18 MΩ-cm deionized water) with 200 μL of 
acetonitrile in a 1.7-mL microcentrifuge tube. 

To prepare 1 mL of Solvent 2

Mix 30 μL of the 0.1% TFA solution prepared above with 130 μL of 200-proof ethanol 
(provided in the kit) and 840 μL of acetonitrile (provided in the kit). 
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Reconstituting the Calibration Mixes

The reconstituted calibration mixes must sit at room temperature for 30 minutes before you 
can use them. To save time, reconstitute the calibration mixes that you plan to use before you 
prepare the matrix solutions. 

• To calibrate the MALDI LTQ XL system in the normal mass range, reconstitute the 
Normal Mass Calibration Mix. 

• To calibrate the MALDI LTQ XL system in the high mass range, reconstitute both the 
Normal and High Mass Calibration Mixes.

To reconstitute the Normal Mass Calibration Mix

1. Add 58 μL of Solvent 1 to a vial containing the Normal Mass Calibration Mix. 

2. Incubate the vial for 30 minutes at room temperature. 

To reconstitute the High Mass Calibration Mix

1. Add 150 μL of Solvent 1 to a vial containing the High Mass Calibration Mix.

2. Incubate the vial for 30 minutes at room temperature.

Preparing the Matrix Solution for the Calibration Targets

To prepare the 10 mg/mL matrix stock solution 

1. Add 0.5 mL of Solvent 2 to one vial of alpha-cyano-4-hydroxycinnamic acid (5 mg in a 
1.7-mL microcentrifuge tube).

2. Vortex or sonicate the mixture until the matrix is completely dissolved. 

To prepare the 3.5 mg/mL matrix solution

1. Transfer 35 μL of the 10 mg/mL matrix stock solution prepared above to a 
microcentrifuge tube.

2. Add 65 μL of Solvent 2 to the microcentrifuge tube. 

3. Label the tube, and briefly vortex the tube. 
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Preparing the Calibrant/Matrix Mixtures

Depending on the mass range that you want to calibrate, prepare one or both of the following 
calibrant/matrix mixtures.

To prepare the calibrant/matrix mixture for the normal mass range

1. If you have not already done so, reconstitute a vial of the Normal Mass Calibration Mix 
as described in “Reconstituting the Calibration Mixes” on page 171.

2. Transfer 5 μL of the reconstituted normal mass calibration mix to a microcentrifuge tube.

3. Add 45 μL of the 3.5 mg/mL matrix solution to the microcentrifuge tube.

4. Label the tube, and briefly vortex the tube.

To prepare the calibrant/matrix mixture for the high mass range

1. If you have not already done so, reconstitute a vial of the High Mass Calibration Mix as 
described in “Reconstituting the Calibration Mixes” on page 171.

2. Transfer 5 μL of the reconstituted High Mass Calibration Mix to a microcentrifuge tube.

3. Add 45 μL of the 3.5 mg/mL matrix solution to the microcentrifuge tube.

4. Label the tube, and briefly vortex the tube.

Spotting the Calibrant/Matrix Mixtures on the Sample Plate

To spot the calibrant/matrix mixtures on the sample plate

1. For each calibrant/matrix mixture that you plan to use, spot 5 or more sample wells on 
the sample plate with 1.5 μL of the calibrant/matrix mixture per well. 

2. Gently use the pipette tip to spread the calibration solution out to the edges of the 
sample well. 

The sample must touch the edges of the well engraving to ensure even drying and 
uniform distribution. You can spread the solution slightly outside of the sample circle if 
necessary. 

3. Continue spotting the sample wells until you have created 5 or more homogeneous spots.

4. Allow the sample spots to dry at room temperature for 1 to 2 minutes. 

IMPORTANT  If the sample does not spread homogeneously over the well, do not use the 
spot for calibration.
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Preparing the Sensitivity Test Targets
Thermo Fisher Scientific recommends that you check the sensitivity of the MALDI LTQ XL 
system before performing analyses on low-concentration samples. The following procedure 
describes how to prepare the sensitivity test targets.

To prepare the sensitivity test targets

1. Prepare Solvent 3, a solution of 50:50 acetonitrile /0.1% TFA in water (v/v):

a. Transfer 100 μL of 0.1% TFA in water to a microcentrifuge tube. 

For instructions on preparing a solution of 0.1% TFA in water, see “Preparing the 
Solvent Mixtures” on page 170.

b. Add 100 μL of acetonitrile to the tube and mix.

2. Reconstitute a vial of angiotensin II:

a. Add 625 μL of HPLC-grade water (or 18 MΩ-cm deionized water) to a vial of 
angiotensin II. 

The 0.5-mL vials contain 500 pmol of angiotensin II. The concentration of the 
reconstituted solution is 800 fmol/μL angiotensin II. 

b. Incubate the vial for 30 minutes at room temperature. 

3. Prepare a 40 fmol/μL solution of angiotensin II:

a. Transfer 5 μL of the reconstituted angiotensin II to a clean, dry microcentrifuge 
tube.

b. Add 95 μL of water to the tube and vortex briefly. 

The final concentration of this solution is 40 fmol/μL angiotensin II. 

4. Prepare a 4 fmol/μL solution of angiotensin II:

a. Transfer 5 μL of the 40 fmol/μL angiotensin II solution from step 3 to a clean, dry 
microcentrifuge tube.

b. Add 45 μL of water to the tube and vortex briefly. 

The final concentration of this solution is 4 fmol/μL angiotensin II. 

5. Prepare a 1 mg/mL matrix solution:

a. Transfer 10 μL of the stock matrix solution (10 mg/mL) to a clean, dry 
microcentrifuge tube.

b. Add 90 μL of Solvent 3 and vortex. 

The final concentration of this solution is 1 mg/mL matrix. 

6. Prepare a 10 fmol angiotensin II target:

a. Transfer 5 μL of the 40 fmol/μL angiotensin II solution prepared in step 3 to a clean, 
dry microcentrifuge tube. 
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b. Add 5 μL of the 1 mg/mL matrix solution prepared in step 5 to the tube.

c. Vortex briefly, and spot 0.5 μL (10 fmol of angiotensin II) onto the sample plate. 

7. Prepare a 1 fmol angiotensin II target:

a. Transfer 5 μL of the 4 fmol/μL Angiotensin II solution prepared in step 4 to a clean, 
dry microcentrifuge tube.

b. Add 5 μL of the 1 mg/mL matrix solution prepared in step 5 to the tube. 

c. Vortex briefly, and spot 0.5 μL (1 fmol angiotensin II) onto the sample plate. 
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Sample Preparation

The quality of your MALDI spectra is highly dependent on sample preparation. The optimal 
conditions can vary considerably from analyte to analyte. Experiment to find the best way to 
prepare your analyte of interest. This appendix contains guidelines on how to prepare and 
deposit samples to be analyzed with the MALDI LTQ XL system. 

Contents

• Matrix

• Matrix Solvent

• Matrix-to-Analyte Ratio

• Sample Purification

• Sample Deposition Techniques

• MALDI Sample Preparation Guidelines

CAUTION  Store and handle all chemicals in accordance with standard safety procedures. 
The Material Safety Data Sheets (MSDSs) describing the chemicals being used are to be 
freely available to lab personnel for them to examine at any time. Material Safety Data 
Sheets (MSDSs) provide summarized information on the hazard and toxicity of specific 
chemical compounds. MSDSs also provide information on the proper handling of 
compounds, first aid for accidental exposure, and procedures for the remedy of spills or 
leaks. Producers and suppliers of chemical compounds are required by law to provide their 
customers with the most current health and safety information in the form of an MSDS. 
Read the material safety data sheets for each chemical you use.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear protective gloves when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. Wear 
safety glasses when you use solvents or corrosives. Refer to your supplier's Material Safety 
Data Sheet (MSDS) for the proper handling of a particular solvent or compound. 
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Matrix
The compound used as the MALDI matrix must meet the following requirements:

• Be capable of co-crystallization with the analyte

• Be soluble in a solvent that is compatible with the analyte

• Have a high absorptivity coefficient at the UV wavelength of 337.7 nm emitted by the 
MALDI laser

• Be chemically non-reactive with the analyte

• Must not sublimate at a pressure of 70 mTorr, the pressure maintained within the sample 
chamber of theMALDI source

Figure 109 shows two compounds commonly used as matrices for peptide analysis with 
MALDI, alpha-cyanohydroxycinnamic acid (CHCA) and 2,5-dihydroxybenzoic acid (DHB). 

Figure 109. Matrix compounds

DHB has a lower internal energy upon desorption than CHCA, and produces less 
fragmentation of analytes. Consequently, DHB is sometimes preferred to CHCA, particularly 
for use with labile biological molecules, such as carbohydrates and proteins with post 
translational modifications. Recrystallized matrices are preferred. Table 15 lists suggested 
suppliers of recrystallized matrices.

Table 15. Ordering information for CHCA and 2, 5-DHB matrixes

Matrix Supplier Part number

CHCA Laser Biolabs, France M001

CHCA Waters 186002331

2,5-DHB Laser Biolabs, France M003

2,5-DHB Waters 186002333

N

OH

OH

O

C

OHO

OH

OH

alpha-cyano-4-hydroxycinnamic acid (CHCA) 2,5-dihydroxybenzoic acid (DHB)
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Matrix Solvent
The solvent used to make the matrix solution can affect the crystallization of the matrix and 
sample. In general, solvent mixtures with higher organic content evaporate more quickly, 
leading to faster crystallization and thinner sample coverage. (Refer to Cohen and Chait, 
19961 for a more detailed description of solvent effects on matrix crystallization.) The solvent 
commonly used for CHCA is 50:50 (0.1% TFA in water)/acetonitrile (v/v). You can use 
another common solvent, 3:13:84 (0.1% TFA in water)/ethanol/acetonitrile (v/v/v), when 
you need a faster evaporation rate. Chromasolv™ or HPLC-grade solvents are recommended.

Matrix-to-Analyte Ratio
The matrix-to-analyte ratio is an important factor in the quality of spectra obtained using the 
MALDI ion source. Many commonly used sample-preparation protocols for MALDI employ 
saturated or near-saturated CHCA. Such concentrations are too high to use with the MALDI 
source, and result in matrix ion signals overwhelming the spectrum. A baseline “hump” in the 
low-mass region (<m/z 1000) might be an indication that too much matrix has been used, 
that the matrix is contaminated, or that the sample plate is dirty. In the case of CHCA, 
adduct peaks (also known as matrix clusters) can appear in the spectrum as a series of peaks 
with an m/z difference of 211 to 212. These adducts are comprised of several molecules of 
CHCA with sodium/and or potassium2,3. 

For samples in the 100 to 500 fmol/μL range, a solution of <2.5 mg/mL CHCA is often a 
good starting point. Lower analyte concentrations require lower matrix concentrations.

Sample Purification
Many common buffers and additives used in handling biological samples can reduce the 
quality of MALDI spectra when present above a particular concentration. These include 
sodium and potassium salts, phosphate buffers, and many detergents and denaturants. Many 
samples need purification to remove these substances before MALDI analysis. (Refer to Mock 
et al., 19924 for more information on problematic compounds.)

A popular purification technique is the use of C-18 containing micro extraction pipette tips 
(such as the Varian OMIX™ tips or Millipore ZipTip™), which allow rapid reverse phase 
purification of small volume protein or peptide samples. Samples can be eluted directly onto 
the MALDI sample plate with the matrix of choice, or can be eluted into a microcentrifuge 
tube with a suitable solvent. The latter option allows for more flexibility in experimenting 
with different matrices and matrix concentrations.

1Cohen, S.; Chait, B. Anal. Chem. 1996, 68, 31-37. 

2Keller, B.O. and Li, L. J Am Soc Mass Spectrom 2000, 11, 88-93.
3 Harris, W.A.; Janecki, D.J., and Reilly, J.P. Rapid Commun. Mass Spectrom 2002, 16, 1714-1722.
4Mock, K.; Sutton, C.; Cottrell, J. Rapid Commun. Mass Spec. 1992, 6, 233-238. 
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Most samples from in-gel digests need a purification step after digestion, but in-gel digests in 
the high picomolar range might not need the purification step.

Lyophilized protein digests are usually resuspended in 10% to 20% acetonitrile in 0.1% TFA. 
Subsequent dilutions can be made with 18 MΩ -cm or HPLC-grade water. 

Sample Deposition Techniques
Many sample deposition techniques have been used with MALDI. This topic describes two 
common sample deposition techniques: the dried-droplet method and the analyte first 
method. 

The dried-droplet method is used in the sample preparation protocols given in this manual. It 
is also the preferred sample deposition method for use with DHB, as well as CHCA. With 
this method, you mix the sample solution and matrix solution, and then load the mixture 
onto a sample plate. You typically use a 1:1 ratio for the sample/matrix mixture, and load the 
sample plate with 0.5 to 1.0 μL of the mixture per spot. You can vary the matrix-to-sample 
ratio. It is important to load the sample/matrix mixture as soon as possible after mixing 
because crystals might form in the mixture. 

The analyte first method is used to improve sensitivity. With this method, you apply 
0.3 to 0.5 μL of sample solution to the sample spot and allow it to dry. Then you apply an 
approximately equal amount of matrix solution to the spot and allow it to dry.

MALDI Sample Preparation Guidelines 
This topic describes sample preparation with either the 2,5-DHB (2,5-dihydroxybenzoic 
acid) or the CHCA (alpha-cyano-4-hydroxycinnamic acid) matrices and contains the 
following procedures:

• Preparing Samples with the 2, 5-DHB Matrix

• Preparing Samples with the CHCA Matrix

• Preparing Phosphorylated Peptides for a Neutral Loss Experiment

Preparing Samples with the 2, 5-DHB Matrix

The preferred matrix for protein digests and labile molecules is 2,5-dihydroxybenzoic acid 
(2,5-DHB) because it causes less fragmentation than CHCA. You can 
use 50:50 acetonitrile/0.1% TFA in water (v/v), or 20:80 acetonitrile/0.1% TFA in water 
(v/v) as the solvent for a 2,5-DHB matrix. Adding 0.1% TFA maintains the acidity of the 
solution below pH 4.

To prepare samples with the 2,5-DHB matrix

1. Prepare a stock solution of 50 mg/mL 2, 5-DHB in 50:50 acetonitrile/0.1%TFA. 
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2. To prepare the target spots, do one of the following:

• For peptides, prepare a 1:1 sample/matrix mixture, and then spot the sample wells of 
the sample plate with 0.3 to 0.5 μL of this mixture. 

• Spot the sample wells with 0.3 to 0.5 μL of the analyte solution. Allow the spot to 
dry, and then apply the same amount of matrix solution on top of the analyte spots.

• Spot a sample well with the analyte solution. Before the analyte solution drys, spot 
the well with the matrix solution. Using a pipette with a disposable tip, mix the 
analyte and matrix solutions by drawing the solution into and expelling the solution 
from the pipette tip. Make sure the dry sample is no larger than 2 mm in diameter, as 
this is the size of the camera view.

Preparing Samples with the CHCA Matrix

Alpha-cyano-4-hydroxycinnamic acid (CHCA) is a universal type of matrix that can be used 
with non-volatile, thermally labile molecules.

If needed, you can add ammonium citrate dibasic (Sigma P/N 09833 or 09831) to the 0.1% 
TFA solution, for a total ammonium citrate concentration of 2 mM in the 50/50 
acetonitrile/0.1%TFA solvent. Signal suppression might occur above 5 mM ammonium 
citrate. This additive has been shown to help with certain contaminants in samples (high salt 
concentrations, certain buffers, and ionic detergents).

To prepare samples with the alpha-cyano-4-hydroxycinnamic acid (CHCA) matrix

1. Prepare a stock solution of 10 mg/mL CHCA in 50:50 acetonitrile/0.1%TFA. 

This stock CHCA solution can be stored for up to a few weeks in a light resistant 
container or in a dark location at 20 °C.

2. Prepare a working solution of 1.0 to 2.5 mg/mL CHCA in the same solvent used to 
prepare the stock solution. If samples are at the attomole level, use the lower CHCA 
solution concentration of 0.5 to 1.0 mg/mL.

Use the working CHCA solution to prepare the target spots. 

3. To prepare the target spots, do one of the following:

• Spot the sample wells with 0.5 μl of the analyte solution. Allow the spots to dry. and 
then apply 0.5 μL of the CHCA working solution (1 mg/mL to 2.5 mg/mL) on top 
of the analyte spots. 

• Use the dried droplet method. Prepare a 1:1 sample/matrix (CHCA working 
solution, 1.0 to 2.5 mg/mL) solution, and then spot the sample wells with 0.5 μL of 
this mixture.
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Preparing Phosphorylated Peptides for a Neutral Loss Experiment

The recommended matrix for observing phosphorylated peptides is 2,5-DHB, making it the 
preferred matrix for the neutral loss, data-dependent method. Samples prepared with CHCA 
tend to show a reduced phosphorylated precursor. Phosphoric acid has been shown to 
improve the sensitivity of the phosphorylated group5.

Preparation of samples containing phosphorylated peptides:

1. Dissolve 2,5-DHB in 50/50 (ACN/0.1% phosphoric acid) solvent

2. Prepare a 1:1 (v/v) matrix to analyte mixture.

3. Load 0.3 to 0.5 μL of this mixture onto each sample well. 

5Kjellström S. and Jensen O.N. Anal. Chem. 2004, 76, 5109-5117.
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